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Copyright 
Copyright   2009 by PLANET Technology Corp. All rights reserved. No part 
of this publication may be reproduced, transmitted, transcribed, stored in a 
retrieval system, or translated into any language or computer language, in 
any form or by any means, electronic, mechanical, magnetic, optical, 
chemical, manual or otherwise, without the prior written permission of 
PLANET. 
PLANET makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties, merchantability or fitness for any particular purpose. Any 
software described in this manual is sold or licensed "as is". Should the 
programs prove defective following their purchase, the buyer (and not 
PLANET, its distributor, or its dealer) assumes the entire cost of all necessary 
servicing, repair, and any incidental or consequential damages resulting 
from any defect in the software. Further, PLANET reserves the right to revise 
this publication and to make changes from time to time in the contents 
hereof without obligation to notify any person of such revision or changes. 
 
All brand and product names mentioned in this manual are trademarks 
and/or registered trademarks of their respective holders. 
 

Federal Communication Commission Interference Statement  

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:   

1. Reorient or relocate the receiving antenna. 

2. Increase the separation between the equipment and receiver. 

3. Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected. 

4. Consult the dealer or an experienced radio technician for help. 

 

FCC Caution  

To assure continued compliance. (example-use only shielded  
interface cables when connecting to computer or peripheral devices). Any 
changes or modifications not expressly approved by the party responsible 
for compliance could void the user’s authority to operate the equipment. 
This device complies with Part 15 of the FCC Rules. Operation is subject to 
the Following two conditions: ( 1 ) This device may not cause harmful 
interference, and ( 2 ) this Device must accept any interference received, 
including interference that may cause undesired operation.  
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Federal Communication Commission (FCC) Radiation Exposure 
Statement 
 
This equipment complies with FCC radiation exposure set forth for an 
uncontrolled environment. In order to avoid the possibility of exceeding the 
FCC radio frequency exposure limits, human proximity to the antenna shall 
not be less than 20 cm (8 inches) during normal operation. 

R&TTE Compliance Statement 

This equipment complies with all the requirements of DIRECTIVE 1999/5/CE 
OF THE EUROPEAN PARLIAMENT AND THE COUNCIL OF 9 March 1999 on 
radio equipment and telecommunication terminal Equipment and the 
mutual recognition of their conformity (R&TTE) 

The R&TTE Directive repeals and replaces in the directive 98/13/EEC 
(Telecommunications Terminal Equipment and Satellite Earth Station 
Equipment) As of April 8, 2000. 

Safety 

This equipment is designed with the utmost care for the safety of those who 
install and use it. However, special attention must be paid to the dangers of 
electric shock and static electricity when working with electrical equipment. 
All guidelines of this and of the computer manufacture must therefore be 
allowed at all times to ensure the safe use of the equipment. 

WEEE regulation 

To avoid the potential effects on the environment and human health 

as a result of the presence of hazardous substances in electrical and 

electronic equipment, end users of electrical and electronic 

equipment should understand the meaning of the crossed-out 

wheeled bin symbol. Do not dispose of WEEE as unsorted municipal     

waste and have to collect such WEEE separately. 
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Chapter 1: Introduction 

PLANET Technology’s NAS-7400 is network attached storage (NAS) solution 

for external storage targeted for small and medium business (SMB) users 

and small office/home office (SOHO) users.  

 

With a NAS product, users can save their work and have access to files over 

the network without having to carry around a disk drive or memory stick. 

The Administrator can manage access privileges for greater security. 

Multiple backup and synchronization functions protect your data. 
 

1.1 Features 

 Up to four hot-swappable SATA II 3.5-inch disk drivers 

 Provides Scalability up to 4TB  

 10/100/1000M - Gigabit Ethernet port 

 RAID level support: RAID 0, 1, 5 and 10 

 Multi-protocol system support for Windows, UNIX, Linux and Macintosh 

 The Administrator can Limit the Amount of Available Disk Space 

Available to Individual Users 

 NAS-to-NAS data synchronization and backup 

 User, group and folder quota control 

 Advanced RAID bad sector recovery mechanism 

 Support UPnP Auto-IP and DHCP client 

 Aluminum Enclosure with an Internal Cooling Fan for Continuous 

Operation 

 2 Standard USB 2.0 Port for External USB HDD and Print Server Sharing 

 Multi-language support and user friendly web management interface 

 UPnP and DLNA certified Digital Media Server 

 Support E-Mail Notification for critical events 

 Support iTunes Media Server 

 Easy-to-use browser-based management interface 

 Data sharing over the network 

 One-touch backup of designated file folders on client PC 

 Snapshot backup for real-time image of the file system 

 Network print server with USB printer 
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 UPS support with automated shutdown 

 Heterogeneous environment: Windows, UNIX, Linux, and Macintosh 

 SmartSYNC Backup & Setup Wizard  

1.2 Protocol Support 

 Windows 2000, XP Professional, 2003 Server, and Vista Business, 

Enterprise, and Ultimate clients through SMB and CIFS protocols 

 UNIX and Linux clients through the NFS protocol 

 Macintosh clients through the AFP protocol 

 FTP clients through the FTP protocol 

 DLNA clients through UPnP protocol with an optional plug-in 

 Up to 16 concurrent connections 
 

1.3 Package Content 

 NAS-7400 x 1 

 User’s Manual CD x 1 

 Power Adapter x 1 

 RJ-45 Cable x 1 

 Screw Package x 1 

 Quick Installation Guide x 1 
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1.4 Specifications 

• Disk drive support:  

• Four 1.5 Gb/s or 3 Gb/s SATA 3.5-inch disk drives 

• Conforms to Serial ATA 1.0 specification and Serial ATA II: 
Extensions to Serial ATA 1.0 specification (SATA II, phase I 
specification) 

• SATA specification of 3 Gb/s transfers with CRC error-checking 

• Hot-swapping of disk drives 

• Tagged command queuing 

• Native command queuing 

• Drive roaming among channels  

• S.M.A.R.T status polled every 15 minutes 

• Online capacity expansion 

• RAID Level Migration 

• Hot spare drives 

• RAID Volume rebuilding 

• Gigabyte rounding 

• Background rebuilding 

• RAID level support: RAID 0, 1, 5, and 10 

• Large file support up to 2 TB 

• Unicode file name support 

• Networking: 10/100/1000 Mb/s Ethernet Port on motherboard 

• File protocols: SMB, CIFS, FTP, AFP, NFS 

• Network Time Protocol (NTP) client 

• Error logging 

• Phone home capability (email notification) to contact IT staff 

• Hardware monitoring of: 

• Fan 

• Temperature 

• Power 

• Disk status 

• One-Touch button 
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• Enclosure status 

 Disk drive support: 

• Four 1.5 Gb/s or 3 Gb/s SATA 3.5-inch disk drives 

• Conforms to Serial ATA 1.0 specification and Serial ATA II: 

Extensions to Serial ATA 1.0 specification (SATA II, phase I 

specification) 

• SATA specification of 3 Gb/s transfers with CRC error-checking 

• Hot-swapping of disk drives 

• Tagged command queuing 

• Native command queuing 

• Drive roaming among channels 

• S.M.A.R.T. status polled every 15 minutes 

• Online capacity expansion 

• RAID Level Migration 

• Hot spare drives 

• RAID Volume rebuilding 

• Gigabyte rounding 

• Background rebuilding 

• RAID level support: RAID 0, 1, 5, and 10 

• Large file system support up to 6 TB 

• Unicode files name support 

• Networking: 10/100/1000 Mb/s Ethernet Port on motherboard 

• USB ports: USB 2.0, up to 480 Mb/s, two Types-A connectors 

• File protocols: SMB, CIFS, FTP, AFP, and NFS 

• Flash Memory: 16 MB, 16-bit 

• Memory: 128 MB DDR SDRAM 

• Power Supply: 200-watt ATX with PFC 

• Network Time Protocol (NTP) client 

• Error logging 

• Phone home capability (email notification) to contact IT staff 
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1.5 Physical Detail 

NAS-7400 Front View 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Power Button 

 

System Status LED 

Disk Status LED 

LAN Activate LED 

One Touch Backup Button 

Disk Activity LED  
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NAS-7400 Rear View 

 

 

Button Description 

Button Description 
Power Button Push to turn on/ turn off the NAS-7400 

One Touch Backup 
Button 

One Touch Backup is a feature that enables you to 
backup specified folders from your PC to the 
NAS-7400 by pressing a button on the front of the 
NAS-7400. 

Reset Button 

If forgot the new password, you can use the reset 

button to the default password: admin. Please press 

and hold the reset button more than 5 seconds, until 

the System Status LED flashes three times. 

 

Physical Interfaces 

Interface Description 
USB Socket Connects to USB printers and USB Storage Devices 

LAN Port Connects to the Ethernet cable with RJ-45 
connector 

Power Connection Connects to the power core 

1 x LAN Port 

Power Port  

2 x USB Ports 

Power 

Supply FAN 

Fan 

Reset Button 
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LED Indicators 

LED Color Function 

Power Blue Unit action indication lamp. 

System 

Status 

Green Normal Enclosure function 

Amber There is a problem with the fan or power 

supply 

Red The fan, power supply, or file system 

has failed.  

Disk Status 

LED 
 

Green Normal disk drive function 

Amber  Rebuilding to this disk drive 

Red Failed disk drive 

Dark No disk drive is installed 
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Chapter 2: Installation 

2.1 System OS Support 

Microsoft Windows: 

• Vista, Server 2003, XP, 2000 

• Supports Intel IA32, AMD64 and Intel EM64T platforms 

UNIX/Linux: 

• Red Hat Enterprise Linux 3.0 (AS/WS/ES)  

• Red Hat Enterprise Linux 4.0 (AS/WS/ES) 

• SuSe Linux Enterprise 10 (Server/Desktop) 

Apple Macintosh: 

• Mac OS X  

 

2.2 System Browser Support 

Use the latest version of the following browsers to manage the NAS-7400: 

• Internet Explorer 

• Netscape Navigator 

• Mozilla 

• Firefox 

• Safari (Mac OS X) 

 

2.3 Getting Start  

This chapter shows you how to configure these steps to connect NAS-7400.  
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Step1 Install Hard Drive into HDD Tray. 

 

 
Step2  Installing Hard Drive into NAS-7400. 

 
 

Step3 Connecting the Network. 
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Step4  Connecting the Power. 

 

 
 

Step5  Press the Power Button. 

 
Step6 Install the Utility. 

 

 

Step7 Use the Software (NAS- Finder) to search NAS-7400. 
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Step8 Login NAS-7400. (Default Login user name/password: admin / 

admin) 

 

Step9 Starting to configure Network Drives.  

 

2.4 Installing the Software - NAS Finder 

After connect the NAS-7400 with your computer or the Local Area Network 

at first time, please install the NAS Finder into your computer. The NAS 

finder will search NAS-7400 automatically.  

 

Note 
By default setting, the NAS-7400 set to “Dynamic IP” mode, 

so it is necessary to setup a DHCP server on network 
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To install the software: 

Step1  Insert the CD into your CDROM, and double-click on Utility 

Installer icon. The first installer screen appears. 

 

 

Step2  Click the “Next” button to begin installation. 
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Step3  The License Agreement screen appears. Please click the “I accept 

the terms of the license agreement” option and click the “Next” button. 

 
 

Step4  Please click on “Next” button to continue the next step. If install to 

different folder, click “Browse” and select another folder. 
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Step5  Please click on “Install” to begin the installation. 

Step6 When the installation is finished, the final installation screen 

appears. Click to “Finish” button to close the installer.

Step7  After finished installation, it will appear the boot-up window, and 

the NAS Finder icon will also show up on the “Toolbar” and “Start Menu ->

Program - > PLANET -> NAS Finder”. 

Starting-up Window
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From Toolbar  

From Start Menu - > Program - > PLANET -> NAS Finder
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Step8  Double click on the “NAS Finder”, it will appear the NAS Finder 

Main screen. 

 

 

2.5 Configure the PLANET NAS-7400 via NAS 
Finder 

 

Note 

The NAS Setup Wizard will overwrite all existing settings on 

the NAS-7400. In most cases, you should only run the NAS 

Setup Wizard one time—when you first set up your PLANET 

NAS Finder 
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The NAS Setup Wizard performs the setup procedures on your NAS-7400.  

To set up your NAS-7400: 

Step1:  Please from “Start -> Programs -> PLANET -> NAS Finder”. 

 

 

The Setup Wizard welcome screen appears. 

  

 

 

 

Set default account 

Set default NAS machine 

Locate NAS 

Do backup now 

Open advanced management 

Tool with Web browser  

Help 



PLANET NAS-7400 User Manual 

 
 

24 

Step2:  Click on the “Set default account” button, and type the default 

login user name/password: admin / admin.  
 

Note 
By default setting, NAS-7400 set to “Dynamic IP” mode, so it 

is necessary to setup a DHCP server on network environment. 
 

 
 

Step3:  The NAS Finder will start to search the NAS device. 

 



PLANET NAS-7400 User Manual 

 
 

25 

Step4:  After search success, double click“nas-7400-25115- 

192.168.0.101”, it will automatically enter to the NAS Finder Main  

Screen as following. 

 

 
 

The NAS Finder Main screen appears. 

 
 

Double Click 
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There are two options on the NAS Finder, 

SmartSYNC - include “Backup/Schedule –NAS, Restore, Schedule 

List, and Event Log”  

 

 

 

Setup Wizard – include “One Click Setup, and Advanced Setup” items. 
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2.6 Connecting to PASM 

The PLANET Advanced Storage Manager (PASM) software is installed on the 

NAS-7400. The PASM runs in the web browser, so you can access PASM via 

web browser. 
 

Browser Support 

Choose one of the following browsers to use with PASM: 

 Internet Explorer 

 Mozilla 

 Firefox 

 Netscape Navigator 

 Safari (Mac OS X) 
 

Finding the NAS-7400’s IP Address 

To access the NAS-7400 in your browser, you must know the NAS-7400’s IP 

address. Use NAS Finder for this purpose. 

Step1   From “Start -> Programs -> PLANET -> NAS Finder”. 

Step2  To open the NAS Finder window, click on the “ ”icon. 

 

 

 

 

Click 
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Step1  The PASM screen will appear automatically. 

 
 

2.7 PASM in your Browser 

To log into PASM in your browser: 

Step1: Start your Browser. 

Step2: In the Browser address field, type in the IP address of the 

NAS-7400. 

 

For example:  

If the NAS-7400’s IP address is 192.168.1.101, the Browser address field 

need to enter: http://192.168.1.101 

The PASM login screen displays. 
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Step3: Enter the login user name and password in the respective fields,    

and then click the “Login” button. 

 

Note 

The default user name and password are both “admin”. 

The user name and password are case sensitive. 

For more information about PASM, see “Chapter 6: PASM”. 



 

 

Chapter 3: Connecting to NAS-7400 

To copy files to and from a folder on the NAS-7400, you must make the 

folder a network drive on your PC. 

To use the NAS-7400 as a print server, you must connect the USB printer, 

enable NAS-74000’s print server, and set up printing on your PC. 
 

3.1 Configure Network Drive on a Windows PC 

If your PC does not have SmartSYNC, use the following procedure to setup 

a Network Drive with My Network Places. 

To setup a network drive: 

i. On the Windows desktop, double-click on the My Network Places 

icon. 

ii. Click the Search button in the toolbar. 

 

iii. If the Search button is not shown, from the View menu, choose 

Toolbars, then Standard Buttons. 

iv. In the Computer name field, type the IP address of the NAS-7400 

and click the Search button.  
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The NAS-7400 appears in the search results list. 

 
 

v. Double-click on the NAS-7400 to show the Public folder and any 

other folders you have created. 

vi. Right-click on the folder you want and choose Map Network Drive 

from the dropdown menu.  
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vii. The Map Network Drive dialog box appears. In the Map 

Network Drive dialog box, choose a drive letter and click the 

Finish button. 

 

viii. Double-click on the My Computer icon on your Windows desktop. 

The folder on the NAS-7400 appears under My Computer as a 

network drive. You can now copy files to and from the folder on the 

NAS-7400.  

 

 

3.2 Setting up a Network Driver on a UNIX or 
Linux PC 

Before you can access the NAS-7400 from a UNIX or Linux PC, you must 

configure the NAS-7400 to communicate with UNIX and Linux. 
 

On the Windows PC 

i. Start PASM. 

ii. In the Tree, click on the + button beside the File & Print icon to 

expand the Tree. 
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iii. Click on the Protocol Control icon and click on the UNIX/Linux tab. 

 

 
 

iv. Click the Enable option, then click the OK button. 

v. The UNIX/Linux protocol enables UNIX and Linux PCs to connect to 

NAS-7400. Click on the File Sharing icon in the tree. 

 
 

vi. Click on the Modify tab. 

vii. Check the UNIX/Linux box and click OK button. 

viii. The UNIX/Linux file sharing enables UNIX and Linux PCs to access 

folders on the NAS-7400. In this case, access is given for the PUBLIC 

folder. 

ix. Click the UNIX/Linux Sharing tab. In the New IP Address field, type 

the IP address of the UNIX/Linux PC from which you want to access 

the NAS-7400. 

 

x. Click the Add button 
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On the UNIX/Linux PC with Command Line Interface 

i. Open a terminal window. 

ii. Create a new folder for the NAS-7400. Type mkdir NSA7400”and 

press Enter. 

iii. Mount the NAS-7400. Type mount 

192.168.1.194:/Volume1/Public /NAS-7400 and press Enter. 

iv. Note that the IP address shown above is only an example. The IP 

address you type in your terminal window will be different. 

v. Volume1 and Public refer to the default Volume and folder created 

during setup. Change to the NAS-7400 directory. Type cd 

/NAS-7400and press Enter. 

vi. You can now copy files to and from the folder on the NAS-7400. 

vii. When you are done with the NAS-7400, type cd; umount 

/NAS-7400and press Enter. 
 

On the Linux PC with Graphic Desktop 

This procedure is for a RedHat Enterprise Linux 4 configuration. If you run a 

different version of Linux, you might have to adapt the procedure. See your 

OS documentation. 

i. From the Applications menu, choose Network Servers. 

ii. In the Network window, double-click on Windows Network. 

iii. Double-click on the NAS-7400 on the network. 

 

iv. Double-click on the folder you want. If this is the first time you 

accessed this folder, an Authentication dialog box opens. 

v. Type the user name and password in the respective fields, then click 

the OK button. 
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The default user name/ password are both admin. 

The user name and password are case sensitive. Leave the Domain field 

blank. The folder opens. You can now copy files to and from the folder on the 

NAS-7400. 

 

3.3 Configure Network Drive on a Macintosh 

PC 

Before you can access the NAS-7400 from a Macintosh (Mac OS X) PC, you 

must configure the NAS-7400 to communicate with the Mac OS. 
 

On the Windows PC 

i. Start PASM. 

ii. In the Tree, click on the + button beside the File & Print icon to 

expand the Tree. 

iii. Click on the Protocol Control icon and click on the Macintosh tab. 

iv. Click the Enable option, and then click the OK button. 

v. The Macintosh protocol enables Macintosh PCs to connect to 

NAS-7400. 
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vi. Click on the File Sharing icon in the Tree. 

vii. Click on the Modify tab. 

viii. Check the Macintosh box and click the OK button. 

ix. The Macintosh file sharing enables Macintosh PCs to access folders on 

the NAS-7400.  

x. In this case, access is given for the PUBLIC folder. 

 
 

On the Macintosh PC 

i. From the Go menu, choose Connect to Server. 
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ii. In the Connect to Server dialog box, type afp://192.168.1.194and 

click the Connect button.  

iii. Note that the IP address shown below is only an example. The IP 

address you type in the dialog box on your Macintosh will be different. 

iv. Click the “+” button to add this IP address to the Favorite Servers list. 

 

v. Type the user name and password in the respective fields, then click 

the OK button. 

vi. The default user name and password are both admin. The user name 

and password are case sensitive. 

 

 

vii. In the NAS-7400 dialog box, click on the folder you want and click the 

OK button. 
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viii. In the NAS-7400 Welcome screen, click the OK button. 

 

 

ix. A window opens on the Macintosh desktop to access the folder on the 

NAS-7400. You can now copy files to and from the folder on the 

NAS-7400.  

 

 

3.4 Connecting a USB Printer to NAS-7400 

To connect a USB printer to the NAS-7400: 

i. Set up your printer according to the printer’s Setup Guide or User 

Manual. Install the printer drivers onto your PC as described in the 

printer’s Setup Guide or User Manual.  

ii. Attach the USB cable from your printer to one of the USB connections 

on the back of the NAS-7400. 

 

 
 

USB Connections 
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3.5 Setting up the Print Server on NAS-7400 

To set up the NAS-7400’s print server: 

i. Start PASM. 

ii. In the Tree, on the left side of the PASM screen, click on the “+” 

button beside the File & Print icon to expand the Tree. 

iii. Click on the Protocol Control icon and click on the Windows tab. 

iv. Click the Enable option button beside Services. 

v. Click the OK button to save your settings. 

vi. Click on the Printer Server tab. 

vii. Click the Enable option button beside Printer Server. 

viii. Click the OK button to save your settings. 

 

 

3.6 Setting up Windows Printing 

To set up printing on a Windows PC: 

i. On the Windows desktop, double-click on the My Network Places 

icon. 

ii. Click the Search button in the toolbar. 

iii. If the Search button is not shown, from the View menu, choose 

Toolbars, then Standard Buttons. 

iv. In the Computer name field, type the IP address of the NAS-7400 and 

click the Search button in the side bar. 

v. In the computer list, double-click on the NAS-7400 to open it. 

vi. If the Connect to dialog box appears, type the user name and 

password in the respective fields, then click the “OK” button. 

vii. The default user name and password are both “admin”. 

viii. The user name and password are case sensitive. 
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ix. Right-click on the usbptr1 icon folder and choose Connect... from the 

dropdown menu. 

 

x. When the warning message about printer drivers appears, click the 

OK button to continue. 

xi. In the Add Printer Wizard, click on the Manufacturer and model name 

of your USB printer, then click the OK button. 

xii. In the Add Printer Wizard, click the OK button. 
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xiii. To verify printer installation, in the Windows Start menu, choose 

Settings, then Printers and Faxes. 

xiv. The Printers and Faxes screen appears. The usbptr1 is the USB printer 

on the NAS-7400.  

 

 

3.7 Setting up Linux Printing 

This procedure is for a RedHat Enterprise Linux 4 configuration. If you run a 

different version of Linux, you might have to adapt the procedure. See your 

OS documentation. 

i. From the Applications menu, choose System Settings, then Printing. 

Printer configuration window opens. 

ii. Click the New button. 

iii. Add a new print queue dialog box opens. 

iv. Click the Forward” button. 

v. In the Name field, type a name for the printer, such as NAS_printer, a 

description, and click the Forward button. 

 

 

vi. From the Select a queue type dropdown menu, choose Network 

Windows (SMB). 

vii. Scroll the list and click on the triangle icon beside NAS-7400. 
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viii. USBPTR01 appears below NAS-7400. USBPTR01 represents the USB 

printer connected to the NAS-7400. 

 

 

ix. Highlight USBPTR01 and click the Forward button. The Authentication 

dialog box opens. 

x. In the User name and Password fields, type admin, then click the 

“OK” button. The user name and password are case sensitive. The 

Printer Model dialog box opens. 

 

 

xi. From the dropdown menu, choose the manufacturer of your printer. 

xii. From the model list, highlight the model of your computer. Then click 

the “Forward” button. 
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xiii. Click the “Finish” button. USBPTR01 is added to your printer list. 

 

 

3.8 Setting up Macintosh Printing 

From the Apple Menu, choose System Preferences. 

i. Double-click on the “Print & Fax” icon. 

ii. Click on the “Setup Printers” button. 

iii. In the Printer List, click on the “Add” icon. The Printer List displays 

a new panel. 

iv. In the new panel, from the popup menus, choose: 

 Windows Printing 

 Workgroup 

v. From the list, highlight the NAS-7400 and click the Choose button. 

 

 

vi. A user name and password dialog box appears. Type the user name 

and password in the respective fields, then click the OK button. 

vii. The default user name and password are both “admin”. The user 

name and password are case sensitive. 
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viii. The printer list displays a new panel. Highlight the USBPTR01 in the 

list. USBPRT01 represents the USB printer connected to the 

NAS-7400. 

 

ix. In the Printer Model popup menu, choose the make of your printer. 

x. In the Model Name list, choose the model of your printer. 

xi. Click the Add button. USBPTR01 is added to your printer list. 
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3.9 Connecting a USB Driver 

To connect a USB drive to the NAS-7400, attach the USB cable from your 

external drive to one of the USB connections on the back of the NAS-7400. 

If you have a USB memory stick, attach it directly to one of the USB 

connections or use a USB cable, whichever is more convenient. 

 

 

The USB drive or memory stick appears as a folder called usbdisk when you 

create your network drive. See the instructions on the following page. 

NAS-7400 supports USB drives and memory sticks formatted to FAT32 or 

Ext3 file formats. If the NAS-7400 does recognize the USB drive or memory 

stick, the usbdisk folder does not appear. 

 

Windows PC 

The USB drive appears as a folder on the NAS-7400 when you create a 

network drive on a Windows PC. 

USB drive connected
to the SmartStor

 

USB Connections 
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Linux PC 

The USB drive appears as a folder on the NAS-7400 when you create a 

network drive on a Linux PC. 

 

 

Macintosh PC 

The USB drive appears as a folder on the NAS-7400 when you create a 

network drive on a Macintosh PC. 

 

 

3.10 Disconnecting a USB Drive 

To disconnect a USB drive or memory stick from the NAS-7400: 

i. Be sure that no files on the USB drive or memory stick are still open. 

ii. Unplug the USB drive or memory stick from the NAS-7400. The 

NAS-7400 automatically unmounts the USB drive or memory stick. 
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Chapter 4: One Touch Backup 

One Touch Backup enables you to make a quick, automated backup of a 

selected folder on your PC, at the touch of a button. You can backup the files 

in a single folder, multiple folders, or your complete hard disk drive. This 

feature works on the Windows PC where you installed the NAS-7400 

software. 

 

Note 

The NAS-7400 utility and One Touch Backup cannot restore a failed boot 

drive in your PC. However, you can use the NAS-7400 utility to save your 

system backup file. See your Windows documentation for information 

about system backups. 
 

 

For One Touch Backup to work, you must: 

 Enable One Touch Backup on the NAS-7400 

 Create a Backup Schedule in SmartSYNC 

 

Note 

Windows does not allow SmartSYNC to access protected folders and files. 

If you want to perform a backup, you must first disable protection on your 

folders and files. 

 

 

4.1 Enable One Touch Backup 

To enable One Touch Backup on the NAS-7400: 

 On the Windows PC, start PASM. 

 In the Tree, click on the “+” button beside the Backup icon and click 

on the “Easy Backup” icon. 
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 On the One Touch Backup tab, click the “Enable” button for One 

Touch Backup Services, then click the “OK” button. 

 

4.2 Creating a Backup Schedule 

For each folder you want to backup, you must create a backup schedule. 

To create a Backup Schedule in SmartSYNC: 

 

 

 

i. In SmartSYNC, click on the “Schedule” tab. 
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ii. Click the “ ” button to allocate the file from the specific 

location you want to backup. 

 

 

 

iii. Click the “Schedule” button to setup the schedule setting: 

 If you chose hours, choose the number of hours from the dropdown 

menu. 

 If you chose daily, choose the time of day in the hour (24-hour clock) 

and minute dropdown menu. 
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 If you chose weekly, choose the time of day and day of the week in 

the hour (24-hour clock), minutes, and day dropdown menus. 

 

 

If finished, please click the “Add” button. 
 

iv. Click the “Backup” to start to backup. 
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4.3 Performing a One Touch Backup  

To perform a One Touch Backup, press the One Touch Backup button on the 

front of the NAS-7400. 

 

 

 

Within moments, the folders you specified are backed up onto the NAS-7400. 

The One Touch Backup function backs up all of the folders on your PC for 

which you created a backup schedule. 
 

4.4 Viewing Your Backup Files 

To view your backup files on the NAS-7400: 

i. On the Windows PC desktop, double-click on the My Computer icon. 

ii. Under Network Drives, double-click on the NAS-7400. 

 

 

iii. On the NAS-7400, find the folder called BACKUPDATA. 

One Touch  

Backup Button 
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iv. The BACKUPDATA folder contains the results of the One Touch Backup 

from your PC. The subfolders inside the BACKUPDATA folder match 

the file structure on your PC’s hard disk drive. 

 

4.5 Restoring Your Backup Files 

 

Note 

The Restore function will overwrite files in the destination folder on your 

PC. 

 If the backup files on the NAS-7400 match the names of the files 

in the restore location folder on your PC, the Restore function will 

overwrite those files on your PC.  

 If you do not want to overwrite the files on your PC, take one of 

the following actions: Move the current files to a different folder 

on your PC. Choose a different restore location folder. 
 
 
To restore backup files from the NAS-7400 to your PC: 

 
 

i. On the Windows PC, open SmartSYNC and click on the Restore tab. 

ii. In the Source field, select the folder that contains the backup files 

that you want to restore. 

iii. In the Source field, folders are identified by their network drive names, 

such as Z, Y, or X. 
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iv. In the Folder List, click on the folders that contain the backup files you 

want to restore. 

v. In the Folder List, folders are identified by their file structure as it was 

copied from your PC. The lowest folder in the structure is the one that 

actually contains the files. 

vi. Choose a restore location: 

 Restore to Original folder - The same folder on your PC from 

which the files were copied for the backup. 

 Restore to a specific folder- A folder on your PC that you specify. 

You can use “ ” to allocate the folder which you want to restore. 

 

vii. Click on “ ” to start. The files are copied from the 

NAS-7400 to your PC. 

viii. If you selected a restore location on your PC other than the original, 

the Restore function includes subfolders that match the files structure 

on your PC’s hard disk drive. 
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Chapter 5: SmartSYNC 

After installation, the SmartSYNC utility starts automatically in the 

background on your Windows PC. SmartSYNC does not run on UNIX, Linux, 

or Macintosh PCs. 

 

 
 

5.1 Opening the SmartSYNC Windows 

To open the SmartSYNC window, double-click on “NAS Finder” on the right 

of toolbar.  
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And then click on the “nas-7400-257115-192.x..xxxx” 

                     
 

The SmartSYNC window opens. 

 
 

5.2 Displaying the NAS-7400 on your Network 

To display the summary of NAS-7400 on your network, open the Setup 

Wizard window. 

The Setup Wizard window opens with the One Click Setup tab selected. A list 

of NAS-7400 appears on One Click Setup tab. 

Double Click 
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5.3 Changing the NAS-7400’s Network 

Settings 

To change the NAS-7400’s network settings: 

 

i. Open the Setup Wizard window. 

ii. Click on the Advanced Setup tab. 
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iii. Click on the Manual option button (right). Type the following into the 

fields provided: 

 Computer Name 

 IP Address Subnet Mask 

 Gateway 

 Primary DNS 

 Secondary DNS. 

 

 

Note 
See your Network Administrator for help in making these 

settings. 

 

iv. Click OK to save your settings. 

 

 

5.4 Performing a Backup 

A Backup copies folders from your PC to the NAS-7400. 

 

Note 

The NAS-7400 and SmartSYNC cannot restore a failed boot 

drive in your PC. However, you can use the NAS-7400 to save 

your system backup file. See your Windows documentation for 

information about system backups. 

 

 

Note 

 Windows does not allow SmartSYNC to access protected 

folders and files. If you want to perform a backup, you 

must first disable protection on your folders and files. 

 If you want to run the Windows Backup or Restore Wizard, 

access the NAS-7400 as a network drive. 
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To perform a backup of a selected folder: 

i. Open the SmartSYNC window. 

ii. Click on the Backup tab. 

iii. Select a Destination. Destinations are identified by drive 

letters and correspond to a specific folder on the NAS-7400. 

iv. Click on the folder you want to backup in the Folder List. 

v. Click the + icon to expand the file tree. A checkmark appears 

beside the selected folder. The backup will include the folder 

you select and all subfolders. 

ii. When you are ready perform the backup, click the Backup 

button (right).  

 

5.5 Viewing Your Backup Folders 

To view your backup folders on the NAS-7400: 

On the Windows desktop, double-click on the My Computer icon. 

i. Under Network Drives, double-click on the NAS-7400. 

ii. On the NAS-7400, find the folder called BACKUPDATA. 

iii. The BACKUPDATA folder contains the results of the One Touch Backup 

from your PC. The subfolders inside the BACKUPDATA folder match 

the file structure on your PC’s hard disk drive. 
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5.6 Performing a Restore 

 

Note 
The Restore function will overwrite files in the destination folder 

on your PC. 

 

A Restore copies folders from the NAS-7400 to your PC. 

 

To perform a Restore of a selected folder:  

 
i. Open the SmartSYNC window. 

ii. Highlight a server in the Server List. 

iii. Click on the Restore tab. 

iv. Select a Source. Sources are identified by drive letters and 

correspond to a specific folder on the NAS-7400. 

v. Choose a restoration location. 

 Restore to original folder– The files from the NAS-7400 will 

overwrite the files on our PC 

 Select to a specific folder– The files from the NAS-7400 are 

saved in a set of folders that match the original file structure from 

where they were copied 
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vi. If you chose a new Restore location, click the Browse button (right) 

, navigate to the destination you want, highlight the destination 

folder and click the Open button to select the folder.  

                                 

vii. In the Folder List, click on the folder you want to restore.  

viii. Click the + icon to expand the file tree. A checkmark appears beside 

the selected folder. The restore will include the folder you select and 

all subfolders. 

ix. Do one of the following actions: 

 To perform the Restore now, click Start button. 

 To perform the Restore later, click the Apply button to save your 

settings. 

When you are ready perform the backup, click the Tools menu and choose 

Restore.  

 

5.7 Scheduling a Backup 

A Backup copies folders from your PC to the NAS-7400. 

 

Note 

The NAS-7400 and SmartSYNC cannot restore a failed boot 

drive in your PC. However, you can use the NAS-7400 to save 

your system backup file. See your Windows documentation for 

information about system backups. 

 

 

Note 

Windows does not allow SmartSYNC to access protected folders 

and files. If you want to perform a backup, you must first disable 

protection on your folders and files. 
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To schedule the backup of a selected folder: 

i. Open the SmartSYNC window. Click on the Schedule tab. 

 
 

ii. Select the Schedule you want to backup. Choose a Schedule 

interval by number of hours, daily, or weekly. Choose a setting: 

 If you chose hours, choose the number of hours from the 

dropdown menu. 

 If you chose daily, choose the time of day in the hour (24-hour 

clock) and minute dropdown menu. 

 If you chose weekly, choose the time of day and day of the 

week in the hour (24-hour clock), minutes, and day dropdown 

menus.  
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Click the Add button. Your Backup Schedule appears in the Schedule tab. 

 

 

 
 

iii. In the Backup Schedule window, verify the Destination. 

Destinations are identified by drive letters and correspond to a 

specific folder on the NAS-7400. In the folder list, click on the + 

icons to expand the tree. 

iv. The Folder List is a representation of the file structure on your PC. 

Click on the folder you want to backup. 

v. A checkmark appears beside the selected folder. The backup will 

include the folder you select and all subfolders. 

 

5.8 Modifying a Backup Schedule 

You can change source folders, time, and day settings for a scheduled 

Backup. 

 

To modify a Backup Schedule: 

i. Open the SmartSYNC window. 

ii. Click on the Schedule tab. 

iii. In the Schedule list, highlight the schedule you want to modify. Click 

the Modify button.  
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iv. Select the Schedule Type (hour, daily, weekly). 

v. Select the time and day settings. 

vi. Click Finish to save your settings. 

 
 

To delete a Backup Schedule 

i. Open the SmartSYNC window. 

ii. Click on the Schedule tab. 

iii. In the Schedule list, highlight the schedule you want to delete. 

iv. Click the Delete button. 

v. In the confirmation box, click Yes. 
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5.9 Viewing the Event Log 

To view the Event Log: 

i. Open the SmartSYNC window. 

 

ii. Click on the Event Log tab. From the Type menu, select the type of 

events you want to display: 

 All – All events 

 Info – Information events only 

 Error – Error events only 
 

Clearing the Event Log 

To clear the Event Log: 

i. Open the SmartSYNC window.  

ii. Click on the Event Log tab. 

iii. Click on Clear All. 

iv. Or, click on the Event menu and choose Clear All. 

 



PLANET NAS-7400 User Manual 

 
 

65 

Chapter 6: The features of PASM 

The Tree is the primary navigation tool in PASM. Categories of functions 

listed with a + sign before the icon. 

Icons for specific functions are listed under the categories. Click the + sign 

to show the functions.  

 

Click on the function icons to display their information on the screen. Each 
function has one or more tabs in its screen. 

 

6.1 Setup Wizard 

If you used the NAS Setup Wizard utility to set up your NAS-7400, you do 
not need to run the Setup Wizard in PASM. 

If you have not yet set up your NAS-7400: 

Step1: In the Tree, click on the + beside the Wizard icon, then on the Setup 

Wizard icon to display the Setup Wizard screen. 
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Step2: Click the “Next” button to start the Setup Wizard. 

 
 

Step3: Configure for the network. 

In the Computer Name field, you can enter a name for the NAS-7400. 

Use only letters, numbers, and the underscore character for the name. 

 
In Network Configuration, please choose one of the following options: 

 Configure using DHCP – Choose this option if your network has a 

DCHP server with addresses available 

 Configure using Specify an IP address – Choose this option if you 

want to set the IP address and other network setting manually 
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If you chose the Configure using Specify an IP address option, type the 

following information in the fields provided: 

 IP Address 

 Subnet Mask 

 Default Gateway IP Address 

  Primary DNS 

  Secondary DNS 
 

If finished, please click the Next button to continue the next step. 
 

Step4: Configure Administrator’s Password Configuration. 

 

 
 

• New Password: Type a new administrator password into the 
New Password field. 

• Retype Password: Retype the new password into the Retype 
Password field. 

 

To add a user, click the Add new user button on New User Configuration 

option. If you clicked the Add new user option button, type a user name and 

password into the fields provided, then click the Add button. 

 

If finished, please click the Next button to continue the next step. 
 

Step5: To check the Enable box to the right of the services you plan to use. 

 Windows – Enables file access from Windows PCs, and it also required 

to use the NAS-7400 as a print server. 
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 Unix/Linux – Enables file access from Unix and Linux PCs 

 Macintosh – Enables file access from Macintosh PCs 

 FTP – Enables file access from PCs using FTP 

 

 
 

To type new names into the Workgroup Name and Computer Description 

fields. 

 

If finished, please click the Next button to continue the next step. 

 

Step6: Configure the File Sharing Configuration, and you must add at least 

one folder which you will access from your PC as a network drive. 

 

To add a folder, click the Add new folder option button. 
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Type a folder name into the field provided, check the boxes of the services 

you expect to use with this folder and click the Add button. Add more folders 

as required. 

 

If finished, please click the Next button to continue the next step. 
 

Step7: RAID Configuration. 

 
If a RAID Volume already exists on the NAS-7400, information about the 

RAID Volume is shown. To change the RAID, you must delete it first and run 

the Setup Wizard again. 

From the RAID Level dropdown menu, select the RAID level you prefer for 

your disk array. 

See for more information. 

Highlight disk drives in the Free Disks column and click the >> button to 

move them to the Disks in RAID column. 
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If finished, please click the Next button to continue. 

 

Step8: Click the Finish button to set up your NAS-7400. 

 

 

The setup process takes several minutes, depending on the size of your disk 

drives. 
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6.2 Managing Users and Groups 

6.2.1 Viewing a List of Users 

To view the list of Users: 

 

In the Tree, click on the + button beside the Users & Groups icon. 

 

6.2.2 Creating a User 

Click on the User Management icon. A list of users appears on the 

Information tab. 
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You can create up to 512 Users. To create or add a new user, please click on 

the “Create User” tab. 

 

 User Name: Type a user name in the field provided. 

 New Password: Type a password into the fields provided. 
 Retype Password: Retype the new password into the Retype 

Password field. 

 

 

If finished, please click the OK button. 
 

6.2.3 Changing the Administrator’s Password 

To change the Administrator’s password, please click Change Password 

tab. 

 
 New Password: Type a new password into the fields provided. 
 Retype Password: Retype the new password into the Retype 

Password field. 

If finished, please click the OK button. 
 

Note 
If you forget your new password, you can push the “Reset” button on the 

rear panel of the NAS-7400 to the default Administrator’s password. 
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6.2.4 Changing a User’s Password 

To change a user’s password, please click Change Password tab, and from 

the User Name dropdown menu, please select the name of the user whose 

password you want to change. 

 

 New Password: Type a new password into the fields provided. 
 Retype Password: Retype the new password into the Retype 

Password field. 

If finished, please click the OK button. 

 

6.2.5 Deleting a User 

You cannot delete the Administrator or the Guest. To delete any other user, 

please click on the Delete User tab. 

 

 
Click the left of the user you want to delete, and then click the OK button to 

delete the user. 
 

6.2.6 Viewing a List of Groups 

Groups are composed of users. You can assign permissions to a group, the 

same as you would do with individual users. 
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To view a list of groups, please click Group Management icon. A list of 

groups appears on the Information tab. 

 

 
 

6.2.7 Creating a Group 

Groups are composed of users. You can assign permissions to a group, the 

same as you would do with individual users. You can create up to 256 

groups. 

 

To create a group, please click Create tab icon. 

 

 Group Name: Type a group name in the field provided. 

 

If finished, please click the OK button. 
 

6.2.8 Adding Members to a Group 

You must create a group before you can assign members to it.  
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To add members to a group, please click Group Members tab. 

i. From the dropdown menu, choose a group to which you want to add 

members. 

ii. Highlight users in the Users column and click the >> button to 

move them to the Members column. 

iii. If finished, please click the OK button. 
 

6.2.9 Removing Members from a Group 

 
To remove members from a group, please click Group Members tab. 

i. From the dropdown menu, choose a group from which you want to 

remove members 

ii. Highlight users in the Members column and click the << button to 

move them to the Users column. 

iii. If finished, please click the OK button. 
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6.2.10 Deleting a Group 

You must remove all members from the group before you can delete the 

group. To delete a group, please click Delete tab. 

 
i. Click the option button next to the group you want to delete. 

ii. If finished, please click the OK button 
 

6.2.11 Viewing Quotas 

Quotas are portions of storage space that you assign to each user or group. 

To view a quota, please click Quota icon. A list of users and groups, and the 

following data appear on the screen: 

 

 
Currently assigned quotas 

 Free space 

 Used space 
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6.2.12 Setting Quotas 

Quotas are portions of storage space that you assign to each user or group. 

Assigning quotas enables you to control how much storage space each user 

or group can access. By default, each user and group is assigned an 

unlimited quota, meaning that any one user or group can access the entire 

storage space. In the Quota screen, the names of groups are preceded with 

a “@”symbol. 

 
 

To set a quota, please click Settings tab. 

i. Highlight the user or group whose quota you want to assign. 

ii. Click on one of the following options: Unlimited and Limited Quota. 

iii. If you chose Limited Quota, type a number into the field provided. 

This number represents how many MB of data the user or group can 

access. 

iv. If finished, please click the OK button. 

 

6.3 Managing File & Print Services 

6.3.1 Configure for Windows Access 

Follow this procedure to set up access from a Windows PC. In the Tree, click 

on the + button beside the File & Print icon. 
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And then click on the Windows tab. 

 

 
i. Click the Enable option button beside Services. 

ii. Type a new Computer Description into the field provided. 

iii. Choose the option button to make the NAS-7400 a member of: An 

Active Directory (AD) Domain or A Workgroup. 

iv. If you chose an AD Domain, enter the following in the fields 

provided: 

 Domain Name 

 Kerberos Key Distribution Center 

 Administrator Name 

 Administrator Password  

 

See your Network Administrator for help with this information. 

 

v. If you chose a Workgroup, enter the Workgroup name into the field 

provided. 
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See your Network Administrator for help with this information. 

 

vi. If finished, please click the OK button to save your settings. 

vii. In the Tree, click on the + button beside the Sharing Setup icon. 

viii. Click Windows Sharing tab. 

 
ix. Select a folder from the Folder Name dropdown menu. 

x. In the User/Group list, highlight the name of a user or group. Group 

names are preceded by the “@” character. 

xi. Under Permissions, choose a permission level for this user or 

group: 

 Deny Access 

 Read Only 

 Read and Write 

xii. Click the OK button to save your settings. 

xiii. You can now access the folder you selected from a Windows PC. 

6.3.2 Configure for UNIX/Linux Access 

Follow this procedure to set up access from a UNIX or Linux PC, please click 

UNIX/Linux tab. 
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i. Click the Enable option button beside Services. 

ii. If you want to join a NIS Domain, click the NIS Domain option 

button. 

iii. If you chose to join a NIS Domain, enter the Domain name into the 

field provided. 

 

See your Network Administrator for help with this information. 

iv. Click the OK button to save your settings. 

v. In the Tree, click on the + button beside the File Sharing icon. 

Click on the Modify tab. 

 

vi. From the Folder name dropdown menu, choose the folder you want 

to access. 

vii. Check the UNIX/Linux box. 

viii. Click the OK button to save your settings. 

ix. In the Tree, click on the + button beside the Sharing Setup icon. 

Click on the UNIX/Linux Sharing tab. 

 

 

x. Select a folder from the Folder Name dropdown menu. 
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xi. In the New IP Address field, type the IP address of the UNIX or 

Linux PC from which you will access this folder and click the Add 

button. 

xii. You must designate the IP addresses for each folder individually. 

You can have up to 256 IP addresses for all of your folders. 

xiii. If finished, please click the OK button to save your settings. 

xiv. You can now access the folder you selected from a UNIX or Linux 

PC. 

6.3.3 Configure for Macintosh Access 

Follow this procedure to set up access from a Macintosh PC, please click on 

the “Macintosh” tab. 

 
i. Click the Enable option button beside Services. 

ii. Click the OK button to save your settings. 

iii. In the Tree, click on the + button beside the File Sharing icon. 

Click on the Modify tab. 

 
 

iv. From the Folder name dropdown menu, choose the folder you want 

to access. 

v. Check the Macintosh box. 

vi. Click the OK button to save your settings. 

vii. You can now access the specified folder from a Macintosh PC.  
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6.3.4 Configure for FTP Access 

Follow this procedure to set up FTP access for your folders: 

 
i. Click the Enable option button beside Services. 

ii. Click the OK button to save your settings. 

iii. In the Tree, click on the “+” button beside the File Sharing icon. 

Click on the Modify tab. 

 

 

iv. From the Folder name dropdown menu, choose the folder you want 

to access. 

v. Check the FTP box. 

vi. Click the OK button to save your settings. 

vii. You can now access the specified folder from your PC using FTP. 

viii. If your FTP client does not support Unicode, only use ASCII 

characters to name your shared folders on NAS-7400. 
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6.3.5 Configure for your Print Server 

Follow this procedure to set up the NAS-7400 as a printer server: 

 
i. Please click on the Windows tab. 

ii. Click the Enable option button beside Services. 

iii. Click the OK button to save your settings. 

iv. Click on the Printer Server tab. 

 

v. Click the Enable option button beside Printer Server. 

vi. Click the OK button to save your settings. 

 

 

Note 

 
The Printer Server tab also verifies that your USB printer is connected and 

online. If you do not see your printer on the Printer Server tab, take the 

necessary action to connect and power the printer.  
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6.3.6 Viewing a List Folders 

A folder is the entity that appears as a Network Drive on your PC.  

 

To view the list of folders, please click on the + button beside the File & 

Print icon, and then click on the File Sharing icon. A list of current folders 

appears in the Information tab. 

 
 

6.3.7 Modifying Folder Services 

Services enable different types of PCs to access your folders. Use this 

function to add or remove a service for a specific folder. 

 

To modify the services on a folder, please click Modify tab. 

 

 Volume dropdown menu: select the RAID Volume containing the 

folder you want to modify. 

 Folder Name dropdown menu: select the folder you want to modify. 
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Check the boxes beside the services you want to use, and click the OK if 

button if finished. 
 

6.3.8 Adding a Folder 

A folder is the entity that appears as a Network Drive on your PC. 

 

To add a folder, please click Create tab. 

 
 Volume dropdown menu: select the RAID Volume in which you want 

to create a new folder. 

 Folder Name field: type a name for your new folder. 

 

Check the boxes beside the services you want to use, and click the OK 

button if finished. 
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6.3.9 Deleting a Folder 

To delete a folder, please click Remove tab. 

 

Click on the option button beside the folder you want to delete. If finished, 

please click the OK button. 

 

Note 
When you delete a folder, you delete all the data saved in the folder. Back 

up any important data before you delete a folder. 
 

 

6.3.10 Configure Windows Sharing for a Folder 

Windows sharing assigns user access the folders on your NAS-7400. By 

default all users and groups have read-only access. 

To set up Windows sharing for a folder,  
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Please click on the Sharing Setup icon, and then click on the Windows 

Sharing tab. 

 Volume dropdown menu: Select the RAID Volume containing the 

folder you want to modify. 

 Folder Name dropdown menu: Select the folder you want to modify. 

 In the User/Group list: Highlight the user or group to which you 

want to assign permissions. 

 

In the Permission list, click on the option button for one of the following 

permissions: 

 Deny Access 

 Read Only 

 Read and Write 

 

If finished, please click the OK button. 
 

6.3.11 Configure the UNIX and Linux Sharing for a Folder 

UNIX and Linux sharing designates which UNIX and Linux PCs can access the 

folders on your NAS-7400. You specify a UNIX or Linux PC by its IP address. 

You can add up to 256 IP addresses for all of your folders. 

You must designate the IP addresses for each folder individually.  

 

To set up UNIX and Linux sharing for a folder, please click on the UNIX/Linux 

Sharing tab. 

 

 From the Volume dropdown menu: Select the RAID Volume 

containing the folder you want to modify. 

 From the Folder Name dropdown menu: Select the folder you want 

to modify. 
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 In the New IP Address field: Type the IIP address of the UNIX or 

Linux PC from which you will access this folder. 

If finished, please click the Add button. 

6.3.12 Configure the FTP Sharing for a Folder 

FTP sharing assigns user access the folders on your NAS-7400. By default all 

users and groups have read-only access. 

 

To set up FTP sharing for a fold, please click on the FTP Sharing tab. 

 

 Volume dropdown menu: Select the RAID Volume containing the 

folder you want to modify. 

 Folder Name dropdown menu: Select the folder you want to modify. 

 In the User/Group list: Highlight the user or group to which you 

want to assign permissions. 

 

In the Permission list, click on the option button for one of the following 

permissions: 

 Deny Access 

 Read Only 

 Read and Write 

 

If finished, please click the OK button. 
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6.4 Managing RAID Volumes 

6.4.1 Viewing RAID Volume Status 

RAID status refers to the disk drives on your NAS-7400 and how they are 

arranged into a RAID Volume.  

 

To view the status of your RAID Volume, 

 

 

i. Please click on the + button beside the RAID & File System icon 

ii. And then click on the RAID Management icon to view the RAID 

status. 

iii. The RAID Status tab displays the current RAID system and its 

status: 

 RAID Name – The name of your RAID, automatically assigned when it 

was created 

 RAID Level – RAID 0, 1, 5, or 10, specified when it was created 

 Capacity – Data capacity of the RAID Volume in GB 

 RAID Status -  

 Functional is normal.  

 Critical means a disk drive has failed.  

 Offline means you cannot access your data. 

 Critical and offline RAIDs require you to take corrective action. 

 Action Status - 

 Idle is normal.  

 Rebuilding means the RAID Volume is being rebuilt after a disk 

drive failure.  

 Migrating means the RAID Volume is adding a disk drive or 

changing RAID levels. 
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 Background Activity - 

 None is normal 

 Running means a background activity is in progress. 
 

6.4.2 Viewing Disk Drive Information 

To view information about a disk drive: 

i. In the Tree, click on the + beside the RAID & File System icon. 

ii. Click on the RAID Management icon. 

iii. The RAID Status tab displays the current RAID system and its 
status. 

iv. In the Disk List, double-click on a disk drive icon. 

v. The disk drive information displays under Disk Status. 

 

6.4.3 Creating a RAID Volume 

On NAS-7400, the term RAID Volume refers to one or more disk drives 

working together as a RAID logical drive.  

You can also use a USB disk to create a RAID Volume. 

You must have unassigned disk drives in your NAS-7400 to create a new 

RAID. 

 

To create a new RAID Volume, and please click on the Create tab. 

i. From RAID Level dropdown menu, select the RAID level you prefer 

for your disk array. 

ii. Highlight disk drives in the Free Disks column and click the >> 

button to move them to the Disks in RAID column. 

iii. If finished, please click the OK button. 

iv. The RAID Volume is created and formatting begins. Formatting 

requires several minutes, depending on the size of your disk drives. 

v. After formatting is done, you must create folders on your RAID 

Volume. 
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6.4.4 Designating a Spare Drive 

If you have an unassigned disk drive, you can assign it as a spare drive. 

 

To assign a spare drive, 

 

i. Click on the RAID Management icon. 

ii. Click on the Create tab. 

iii. From the RAID Level dropdown menu, select Spare Disk. 

iv. Highlight disk drive in the Free Disks column and click the “>>” 

button to move it to the Disks in RAID column. 

v. If finished, please click the OK button. 
 

6.4.5 Migrating a RAID Volume 

To migrate a RAID Volume means to change its RAID level or to add disk 

drives. 

 
To migrate a RAID Volume, 

i. Click on the RAID Management icon. 

ii. Click on the Modify tab. 

iii. From the Current Volume dropdown menu, select the RAID Volume 

which you want to modify. 

iv. In the Migrate to RAID Level dropdown menu, select the target 

RAID Level. 

v. To add disk drives, highlight disk drives in the Free Disks column 

and click the >> button to move them to the Disks in RAID column. 

vi. If finished, please click the OK button. 
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vii. The RAID Volume is modified as you directed. Migration requires 

several minutes, depending on the type of modification taking place 

and the size of your disk drives. 

viii. During the modification, your RAID Volume and all of the folders on 

it are fully accessible. 

ix. After the Migration is completed, you must extend the file system in 

order to use the storage space you have added. You can extend the 

file system immediately or wait until later. 

x. Click on the File System Management icon. 

xi. In the File System Status tab, click on the Extend File System 

button. 
 

6.4.6 Deleting a RAID Volume 

 
 
To delete a RAID Volume; please click on the Delete tab. 

i. Click the option button beside the RAID Volume you want to delete. 

ii. Click the OK button. 

iii. In the confirmation box, type yes into the field provided and click 

the OK button. 

iv. After a RAID Volume is deleted, the NAS-7400 reboots 

automatically.  

v. When the NAS-7400 is fully booted: 

 

 The System Status LED turns green (right) 

 The buzzer beeps one time (if the buzzer is enabled) 

 

 Close your browser then restart the browser to access PASM. 

System 

Status LED 
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Note 

When you delete a RAID Volume, you delete all the folders in the RAID 

volume and all the data saved in the folders. Back up any important data 

before you delete a RAID Volume. 
 

 

Note 
You cannot delete a RAID Volume while a background activity is running, 

such as Migration or Rebuild. Wait until these activities are completed. 
 

 

6.4.7 Viewing an External USB Driver or Memory Stick 

To view a USB drive or memory stick attached to the NAS-7400, please click 

on the “File System Management” icon. 

 

 

The USB drive or memory stick appears as a Volume called USBDISK. 

 

You do NOT create a RAID Volume or folders with the USB drive or memory 

stick as you would with the disk drives installed in the NAS-7400 enclosure. 

With the USB drive or memory stick connected to the NAS-7400, create a 

network drive on your PC and choose the USB disk as the folder. Then you 

can access the USB drive or memory stick from your PC. 

 

6.4.8 Formatting an External USB Driver or Memory Stick 

This option only appears when NAS-7400 does not recognize the file system 

on the USB drive or memory stick. 
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To format a USB drive or memory stick: 

i. Attach the USB drive or memory stick to one of the USB ports on 

the back of the NAS-7400. 

ii. Click on the “File System Management” icon. 

iii. On the “File System Status” tab, highlight the USB drive. 

iv. From the Format File System Type dropdown menu, choose a file 

system: 

 FAT 32 – Use for Windows, Linux, and Macintosh PCs, and 

NAS-7400 

 Ext3 – Use for UNIX and Linux PCs, and NAS-7400 

 

 Click on the “Format USB Disk” button. 

 In the confirmation box, type “yes”, then click the “OK” button. 

 Formatting requires several minutes, depending on the size of your 

USB drive or memory stick. 
 

 

Note 
When you format a USB drive or memory stick, you delete all the data 

saved on it. Back up any important data before you format. 
 

6.5 Managing Backups 

6.5.1 Viewing a List if Snapshot Backups 

To view the list of Snapshot backups: 

 
i. In the Tree, click on the + beside the Backup icon. 

ii. Click on the Snapshot Backup icon. 

iii. The current list of Snapshots displays on the Information tab. 
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6.5.2 Setting up a Snapshot Backup 

Note Setting up a Snapshot will delete all existing snapshots. 
 

To setup a Snapshot Backup: 

 

i. In the Tree, click on the + beside the Backup icon. 

 

ii. Click on the Snapshot Backup icon. 

iii. Click on the Setup tab. 

iv. From the Volume dropdown menu, select the RAID Volume you 

want to backup. 

v. Next to Snapshot Status, click the Enable option. 

vi. In the Reserve Capacity dropdown menu, select a portion in GB of 

the RAID Volume you want to reserve for snapshots. 

vii. Click the OK button.  

viii. In the confirmation box, type yes into the filed provided than click 

the OK button. 
 

6.5.3 Viewing the NAS Replication Schedule 

NAS Replication is a feature that uses one NAS-7400 to backup the data on 

another NAS-7400. The two NAS-7400 systems must be on the same 

network. 
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To view the NAS Replication schedule: 

 

i. In the Tree, click on the + beside the Backup icon. 

ii. Click on the NAS Replication icon. 

The current schedule displays on the Information tab. 

 Role:  

 Standalone – No backup server was specified 

 Primary Server – This NAS-7400 is the primary, the other           

NAS-7400 is the backup 

 Backup Server – This NAS-7400 is the backup, the other  

NAS-7400 is the primary 

 Primary or Backup Server – The IP address of the other 

NAS-7400 on the network. 

 Schedule -- Replication schedule in number of hours, daily or 

weekly. Appears on the primary server. 
 

6.5.4 Setting up NAS Replication 

To set up NAS replication: 

 

i. In the Tree, click on the + beside the Backup icon. 

ii. Click on the NAS Replication icon. 

iii. Click on the Setup tab. 
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iv. Under Settings, click the Role option button to assign a role to this 

NAS-7400: 

 Standalone – Use this option when you only have one NAS-7400 

on your network. This is the default setting and it disables NAS 

Replication. 

 Primary – This NAS-7400 is the primary and the other NAS-7400 is 

the backup server. 

 Backup Server – The other NAS-7400 is the primary and this 

NAS-7400 is the backup server. 

v. If you chose Primary or Backup Server, type the IP address of the 

other NAS-7400 on your network. 

vi. Under Schedule, click the option button for the schedule type you 

want: 

 Disable – Disables NAS Replication 

 Do it at once– Performs a NAS Replication when you click the OK 

button. 

 Time interval by hour – Set an hourly interval for NAS 

Replications to happen. 

 Daily – Sets the time of day when the NAS Replications happen. 

 Weekly – Sets the time of day and day of the week when the NAS 

Replications happen. 

vii. Click the “OK” button. 
 

6.5.5 Enabling One Touch Backup 

One Touch Backup is a feature that enables you to backup specified folders 

from your PC to the NAS-7400 by pressing a button on the front of the 

NAS-7400. 

 

One Touch 

Backup Button  
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To enable One Touch Backup: 

 

i. In the Tree, click on the “+” button beside the “Backup” icon. 

ii. Click on the “Easy Backup” icon. 

iii. In the “Easy Backup” tab, click on the “Enable” option. 

iv. Click the “OK” button. 
 

6.6 Managing the Network Connection 

6.6.1 Viewing Network Setup Information 

To view network setup information: 

 

i. In the Tree, click on the + beside the Network icon. 

ii. Click on the Network Setup icon. The current network setup for this 

NAS-7400 displays on the Information tab: 

 Computer Name 

 IP Address 

 Subnet Mask 

 Default Gateway IP Address 

 Primary Domain Name Server IP Address 

 Secondary Domain Name Server IP Address 

 To change these settings, click on the Setup tab. 
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6.6.2 Making Network Settings  

To make network settings: 

 
i. In the Tree, click on the + beside the Network icon. 

ii. Click on the Network Setup icon. 

iii. Click on the Setup tab. 

iv. Type a name for the NAS-7400 in the Computer Name field. 

v. Click on an option button to choose an Internet Protocol option: 

 Obtain an IP address automatically – Choose this option to let 

your DHCP server make the network settings. 

 Specify an IP address – Choose this option if you want to make 

your network settings manually. 

vi. If you chose Specify an IP address, enter the following settings in 

the fields provided: 

 IP Address 

 Subnet Mask 

 Default Gateway IP Address 

 Primary Domain Name Server IP Address 

 Secondary Domain Name Server IP Address 

 

See your Network Administrator for help in making these settings. 

Click the OK button to save your settings. 
 

6.6.3 Working with Jumbo Frames 

The term jumbo frame refers to a frame on a local area network that is larger 

than the standard 1518 byte size. NAS-7400 supports jumbo frames up to 

9000 bytes. 
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On NAS-7400, the frame size setting is called Maximum Transmission Unit 

(MTU). The default MTU or frame is 1500 bytes. This setting is appropriate 

for most users. See your Network Administrator before you change this 

setting. 

 

To make frame size settings: 

 

i. In the Tree, click on the + beside the Network icon. 

ii. Click on the Network Setup icon. 

iii. Click on the Jumbo Frame tab. 

iv. From the MTU dropdown menu, select the maximum MTU or frame 

size: 

 1500 bytes (default) 

 4000 bytes 

 7000 bytes 

 9000 bytes 

v. Click the OK button to save your setting. 
 

6.7 Making Management Settings 

6.7.1 Viewing the Event Log 

The event log keeps a log of the 20 most recent events on the NAS-7400. 

You can use this information to review your actions and to diagnose 

problems. 
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To view the Event Log: 

 
i. In the Tree, click on the + beside the Management icon. 

ii. Click on the Event Log icon. 

 A list of the 20 most recent events displays on the Event Log tab. 

 Events are ranked in severity as Information, Warning, and 
Error. 

 

6.7.2 Setting up SMTP Authentication 

In order to set up email alerts over a network, you must enable the SMTP 

service, specify a SMTP server, and in most cases, supply authentication 

information. See your Network Administrator for help with these settings. 

To set up SMTP authentication: 

 

i. In the Tree, click on the + beside the Management icon. 

ii. Click on the Mail Alert icon. 

iii. Click on the Setup tab. 

iv. Next to Service, click on the Enable option button. 

v. In the SMTP Server field, type the IP address or the DNS name 
of your SMTP server. 
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vi. In the field, the sender’s email address that you want to appear 
in the alert messages. 

vii. Next to SMTP Authentication: 

• Click on the Yes option button to enable authentication. 

• Click on the No option button to disable authentication. 

Note: The most SMTP servers require authentication. 

viii. If you enabled authentication, to the following: 

• In the User Name field, type the mail server account name. 

• In the Password field, type the password of the mailer server 
account. 

ix. Click the OK button. 

 

6.7.3 Viewing the Email Alert List 

The NAS-7400 will send alerts via email to the recipients you designate. 

To view a list of Email Alert recipients: 

 
i. In the Tree, click on the + beside the Management icon. 

ii. Click on the Mail Alert icon. 

The list of recipients displays on the Mail List tab. 

 

6.7.4 Adding an Email Alert Recipient 

You can have up to 32 Email Alert recipients. 

To add an Email Alert recipient: 
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i. In the Tree, click on the + beside the Management icon. 

ii. Click on the Mail Alert icon. 

iii. Click on the Add tab. 

iv. In the E-Mail Address field, type the recipient’s email address. 

v. Click the OK button. 

 

6.7.5 Deleting an Email Alert Recipient 

To delete an Email Alert recipient: 

 

i. In the Tree, click on the + beside the Management icon. 

ii. Click on the Mail Alert icon. 

iii. Click on the Delete tab. 

iv. Click the option button beside the E-Mail Address you want to delete. 

v. Click the OK button. 

vi. In the confirmation box, click the OK button. 
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6.7.6 Enabling and Disabling the Buzzer 

The NAS-7400 has a buzzer that sounds when the NAS-7400 is finished 
booting and when a problem is detected. The buzzer is enabled by 
default. 

 
PLANET recommends that you leave the buzzer enabled. 

To disable the buzzer: 

i. In the Tree, click on the + beside the Management icon. 

ii. Click on the Buzzer icon. 

iii. Click on the Disable option button. 

iv. Click the OK button. 

v. Click the Enable option button and click the OK button to enable the 
buzzer. 

 

6.7.7 Viewing UPS Status 

If you have an APC Uninterruptable Power Supply (UPS) attached to the 

NAS-7400, you can check its status in PASM. 

To view UPS status: 
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i. In the Tree, click on the + beside the Management icon. 

ii. Click on the APC UPS icon. 

iii. The Information tab displays the status of the UPS. 

iv. If there is no UPS connected or recognized, the Status field reports 
“NO UPS.” 

 

6.7.8 Setting up a UPS 

To set up a UPS: 
i. Attach the APC UPS to one of the NAS-7400’s USB ports. 

ii. In the Tree, click on the + beside the Management icon. 

iii. Click on the APC UPS icon. 

iv. Click on the Setup tab. 

The Setup tab enables you to tell the NAS-7400 how and when to 
shutdown after a power failure.  

Click the option button beside the shutdown option you want: 

• Disable - The NAS-7400 will continue to run until the UPS battery 
is depleted 

• Shutdown when the UPS reaches a set percentage of reserve 
power 

• Shutdown when the UPS reaches a set number of minutes of 
remaining runtime 

• Shutdown after running on the UPS batteries for a set number of 
minutes 

v. If you selected battery percentage, type a percentage amount in  

the % field. 

vi. If you selected running time, type the number of minutes into the  

Mins. field. 

vii. Click the OK button. 
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6.8 Managing Services 

6.8.1 Setting System Date and Time 

To set the date and time on the NAS-7400: 

 

i. In the Tree, click on the + beside the System icon. 

ii. Click on the Date / Time icon. 

iii. Click on the Setup tab. 

iv. From the dropdown menus, choose the time and date values. 

v. Click the OK button. 

 

6.8.2 Running the Network Time Protocol 

You can use the Network Time Protocol (NTP) to set the system date and 

time on your NAS-7400 to synchronize itself with an external Time Server. 
To run the Network Time Protocol: 

 
i. In the Tree, click on the + beside the System icon. 

ii. Click on the Date / Time icon. 
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iii. Click on the Time Zone tab. 

iv. From the dropdown menu, select the time zone for your 
location. 

v. Click the OK button. 

vi. Click on the NTP tab. 

vii. In the Time Server field, type the URL of the time server you 
want to use. 

URL time.nist.gov is the default. 

viii. Under Schedule, choose one of the options: 

• Disable – Disables NTP synchronization  

• Do it at once – Performs a synchronization when you click the OK 
button. 

• Time interval by hour – Set an hourly interval for a 
synchronization to happen. 

• Daily – Sets the time of day when the synchronization happens. 

• Weekly – Sets the time of day and day of the week when the  

ix. Click the OK button. 

 

6.8.3 Viewing the Results of NTP Synchronization 

To view the results of NTP synchronization: 

i. In the Tree, click on the + beside the System icon. 

ii. Click on the Date / Time icon. 

iii. Click on the NTP tab. 

The results of the latest synchronization are displayed: 

• Last Synchronization Time – Time and date of the last 
synchronization 

• Last Synchronization Result – OK means success 

 

6.8.4 Rebooting the NAS-7400 

Normally you will only need to reboot the NAS-7400 is after a firmware 
upgrade. 

During the reboot, none of your folders will be accessible from your 
network PCs. 
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To reboot the NAS-7400: 

 
i. In the Tree, click on the + beside the System icon. 

ii. Click on the Reboot / Shutdown icon. 

iii. Click on the Reboot option. 

iv. Click the OK button. 

v. In the confirmation box, click the OK button. 

The reboot runs automatically. When the NAS-7400 is fully booted: 

• The System Status LED turns green (right) 

• The buzzer beeps one time (if the buzzer is enabled) 

 
 

6.8.5 Shutting Down the NAS-7400 

The only time you need to shut down the NSA-7400 is to replace the disk 
drive cooling fan or the power supply. See “Appendix B: Maintenance”  

During and after the shutdown, none of your folders will be accessible 
from your network PCs. 

To shut down the NAS-7400: 

 

System 

Status LED 
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i. In the Tree, click on the + beside the System icon. 

ii. Click on the Reboot / Shutdown icon. 

iii. Click on the Shutdown option. 

iv. Click the OK button. 

v. In the confirmation box, click the OK button. 

 
 

6.8.6 Restarting the NAS-7400 

The only time you need to shut down the NAS-7400 is to replace the disk 

drive cooling fan or the power supply. See “Appendix B: Maintenance”  

During and after the shutdown, none of your folders will be accessible from 

your network PCs. 

 

To shut down the NAS-7400: 

i. In the Tree, click on the “+” button beside the “System” icon. 

ii. Click on the “Reboot / Shutdown” icon. 

iii. Click on the “Shutdown” option. 

iv. If finished, please click the “OK” button. 
 

Power Button 
System 

Status LED 
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6.8.7 Viewing System Information 

To view system information: 

 

i. In the Tree, click on the “+” button beside the “System” icon. 

ii. Click on the Reboot / Shutdown icon. 

iii. Click on the System Information tab. System Information includes: 

 Operating System – Embedded Linux 

 Firmware Version – Changes when you upgrade the firmware.  

 CPU model – MPC 8343 

 Network Adapter – Gigabit Ethernet 

 Network Flow – Inflow and Outflow speeds in bits per second 
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6.8.8 Viewing Enclosure Information 

To view enclosure information: 

 
i. In the Tree, click on the “+” button beside the “System” icon. 

ii. Click on the “Reboot / Shutdown” icon. 

iii. Click on the “Enclosure Information” tab. Enclosure Information 

includes: 

 CPU temperature 

 System temperature 

 System Fan Speed 

 Power Status 5V 

 Power Status 12V 

 Power Status 3.3V 
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Chapter 7: Technology Background 

7.1 Introduction to RAID 

RAID (Redundant Array of Independent Disks) allows multiple disk drives to 

be combined together into a RAID Volume. You create a RAID Volume on 

your NAS-7400 when you perform the setup procedure, either in the NAS 

Setup Wizard or the PASM Setup Wizard. 

 

The benefits of a RAID can include:  

 Higher data transfer rates for increased server performance 

 Increased overall storage capacity for a single Volume 

 Data redundancy/fault tolerance for ensuring continuous system 

operation in the event of a disk drive failure 

 

Different RAID levels use different organizational models and have varying 

benefits.  
 

7.1.1 RAID 0 – Stripe 

When a RAID Volume is striped, the read and write blocks of data are 

interleaved between the sectors of multiple disk drives. Performance is 

increased, since the workload is balanced between drives or “members” that 

form the RAID Volume. Identical drives are recommended for performance 

as well as data storage efficiency. 

 

Data
Stripe

disk drives
 

RAID 0 Striping interleaves data across multiple drives 
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The RAID Volume’s data capacity equals the capacity of the smallest disk 

drive times the number of disk drives. For example, one 100 GB and three 

120 GB drives will form a 400 GB (4 x 100 GB) RAID Volume instead of 460 

GB.  

If disk drives of different capacities are used, there will also be unused 

capacity on the larger drives. 

Because RAID 0 does not offer Fault Tolerance, meaning that you cannot 

recover your data after a disk drive failure, RAID 0 Volumes on NAS-7400 

consist of one or more disk drives. 
 

7.1.2 RAID 1 – Mirror 

When a RAID Volume is mirrored, identical data is written to a pair of disk 

drives, while reads are performed in parallel. The reads are performed using 

elevator seek and load balancing techniques where the workload is 

distributed in the most efficient manner. Whichever drive is not busy and is 

positioned closer to the data will be accessed first. 

With RAID 1, if one disk drive fails or has errors, the other mirrored disk 

drive continues to function. This is called Fault Tolerance. Moreover, if a 

spare disk drive is present, the spare drive will be used as the replacement 

drive and data will begin to be mirrored to it from the remaining good drive. 

 

Data Mirror

disk drives
 

RAID 1 Mirrors identical data to two drives 

 

The RAID Volume’s data capacity equals the smaller disk drive. For example, 

a 100 GB disk drive and a 120 GB disk drive have a combined capacity of 100 

GB in a mirrored RAID Volume.  

If disk drives of different capacities are used, there will also be unused 

capacity on the larger drive. 

RAID 1 Volumes on NAS-7400 consist of two disk drives. 
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7.1.3 RAID 5 – Block Striping with Distributed Parity Mirror 

RAID 5 organizes block data and parity data across the disk drives. Generally, 

RAID level 5 tends to exhibit lower random write performance due to the 

heavy workload of parity recalculation for each I/O. RAID 5 works well for 

file, database, application and web servers. 

 

Data
Blocks

Distributed Parity

disk drives
 

RAID 5 Stripes all drives with data and parity information 

 

The capacity of a RAID 5 Volume equals the smallest disk drive times the 

number of disk drives, minus one. Hence, a RAID 5 Volume with four 100 GB 

disk drives will have a capacity of 300 GB. A RAID Volume with two 120 GB 

disk drives and one 100 GB disk drive will have a capacity of 200 GB. 

RAID 5 is generally considered to be the most versatile RAID level. 

RAID 5 requires a minimum of three disk drives. 
 

7.1.4 RAID 10 – Mirror / Stripe 

Mirror/Stripe combines both of the RAID 0 and RAID 1 types. RAID 10 can 

increase performance by reading and writing data in parallel while 

protecting data with duplication. At least four disk drives are needed for 

RAID 10 to be installed. With a four-disk-drive RAID Volume, one drive pair 

is mirrored together then striped over a second drive pair. 
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Data Stripe

Data
Mirror

disk drives
 

RAID 10 takes a data mirror on one drive pair and stripes it over two drive 

pairs 

 

The data capacity RAID 10 Volume equals the capacity of the smallest disk 

drive times the number of disk drives, divided by two.  

In some cases, RAID 10 offers double fault tolerance, depending on which 

disk drives fail. 

RAID 10 Volumes on NAS-7400 consist of four disk drives. 

Because all of the available disk drives are used for the RAID Volume, you 

cannot set up a spare drive with RAID 10. 
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7.2 Choosing a RAID Level 

There are several issues to consider when choosing the RAID level for your 

Volume. The following discussion summarizes some advantages, 

disadvantages and applications for each choice. 
 

RAID 0 

Advantages Disadvantages 

Implements a striped disk RAID 

Volume, the data is broken down into 

blocks and each block is written to a 

separate disk drive 

I/O performance is greatly improved 

by spreading the I/O load across many 

channels and drives 

No parity calculation overhead is 

involved 

Not a true RAID because it is not 

fault-tolerant 

The failure of just one drive will 

result in all data in an RAID 

Volume being lost 

Should not be used in mission 

critical environments 

 

Recommended applications for RAID 0: 

 Image Editing 

 Pre-Press Applications 

 Any application requiring high bandwidth 
 

RAID 1 

Advantages Disadvantages 

Simplest RAID storage subsystem 

design 

Can increase read performance by 

processing data requests in parallel 

since the same data resides on two 

different drives  

Very high disk overhead - uses 

only 50% of total capacity 

 

Recommended applications for RAID 1: 

 Accounting/Financial 

 Payroll 
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 Any application requiring very high availability 

 

RAID 5 

Advantages Disadvantages 

High Read data transaction rate 

Medium Write data transaction rate 

Good aggregate transfer rate 

Most versatile RAID level 

Disk failure has a medium 

impact on throughput 

 

Recommended applications for RAID 5: 

 File and Application servers  

 WWW, E-mail, and News servers 

 Intranet servers 

 

RAID 10 

Advantages Disadvantages 

Implemented as a mirrored RAID 

Volume whose segments are RAID 0 

RAID Volumes 

High I/O rates are achieved thanks to 

multiple stripe segments 

Very high disk overhead – 

uses only 50% of total 

capacity 

 

Recommended applications for RAID 10: 

 Imaging applications  

 Database servers  

 General fileserver 
 

7.2.1 TB Limitation  

In order to be compatible with different Operating Systems and the files 

systems that each one supports, the largest RAID Volume you can create on 

NAS-7400 is 2 TB.  
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7.3 Spare Drive 

A spare is a disk drive that has been designated to replace a failed disk drive 

in a RAID Volume. In the event of the failure of a disk drive within a RAID 1 

or three-drive RAID 5 Volume, the spare drive is activated as a member of 

the RAID Volume to replace a disk drive that has failed.  

A spare drive cannot replace the failed drive in a RAID 0 Volume because of 

the way in which data is written to the disk drives under RAID 0.  

A spare drive is not available for a RAID 10 Volume because RAID 10 

requires all four disk drives in the NAS-7400 enclosure. However, when you 

replace the failed disk drive, the NAS-7400 will automatically rebuild the 

RAID Volume using the new disk drive. 

You must designate a disk drive as a Spare. By default, and unassigned disk 

drive is Free. Use PASM to designate the Free disk drive as a Spare.  
 

7.4 Automatic Rebuilding 

When a disk drive in your RAID 1, 5, or 10 Volume fails, and a replacement 

disk drive become available, the RAID Volume will rebuild itself to the new 

disk drive automatically. 

For RAID 1 and three-drive RAID 5 Volumes, you can designate a spare drive. 

If a spare drive is present when the RAID Volume experiences a disk drive 

failure, the rebuild will start automatically using the spare drive. 

For RAID 1, RAID 5, and RAID 10 Volumes without a spare drive, the RAID 

Volume will begin to rebuild itself automatically when you remove the failed 

disk drive and install a new disk drive. 

A RAID 0 Volume cannot be rebuilt because of the way in which data is 

written to the disk drives under RAID 0. Even if there is a designated spare 

drive, rebuilding is not possible for RAID 0 Volumes. 
 

7.5 Partition and Format 

When you create a RAID Volume on NAS-7400, the RAID Volume is 

automatically partitioned and formatted for you. 

To use your RAID Volume, you must create Folders on the RAID Volume and 
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assign services to those Folders according to your requirements. NAS-7400 

provides file services for Windows, UNIX/Linux and Macintosh, so all of those 

PCs can access the folders on the NAS-7400, even though each PC might 

have a different file system. 
 

7.6 RADI Volume Migration 

Migration is the process of: 

 Changing the RAID level  

 Adding disk drives but keeping the same RAID level  

 

In the migration process, the existing RAID Volume is called the Source. The 

proposed RAID Volume is called the Target. Each target RAID Volume has 

certain requirements and they are different for each RAID level. You must 

meet all of the requirements in order to successfully migrate a RAID Volume. 

In most cases, you must add one or more disk drives during the migration 

process. You can never reduce the number of disk drives. 

While the migration is running, you can still access the folders on your RAID 

Volume and the data they contain. 

The tables below shows the migration options for a source RAID Volume 

according to its RAID level. The available target RAID levels are shown with 

their requirements. 
 

RAID 0 

A RAID 0 source Volume can migrate to the following target RAID levels: 

Target Requirements 

RAID 0 Add disk drives. 

RAID 1 2 disk drives only. 

Only a 1-drive RAID 0 can migrate to RAID 1. Add 1 

disk drive.  

RAID 5 3 disk drives minimum. 

At least 1 more disk drives than the RAID 0 RAID 

Volume.  
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RAID 1 

A RAID 1 source Volume can migrate to the following target RAID levels: 

Target Requirements 

RAID 0 Can use same number of disk drives. 

RAID 5 3 disk drives minimum. 

At least 1 more disk drive than the RAID 1 RAID 

Volume.  

 

RAID 5 

A RAID 5 source Volume can migrate to the following target RAID levels: 

Target Requirements 

RAID 0 Can use same number of disk drives. 

RAID 5 Add a disk drive. 

 

RAID 10 

A RAID 10 source Volume cannot migrate or add more disk drives. 
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Chapter 8: Troubleshooting 

8.1 Responding to an Audible Alarm 

The NAS-7400 has two beep patterns 

 Single beep, not repeated – The NAS-7400 is online 

 Two beeps, continuously repeated – The NAS-7400 reports a 

problem 
 

When you boot or reboot the NAS-7400, and the buzzer is enabled, the 

buzzer sounds one time to indicate that the NAS-7400 is online. 

If you hear the two-beep pattern, check the following items: 
 System Status LED  

 Drive Status LED 

 RAID Volume status in NAS-7400 

 File System status in NAS-7400 

 Enclosure status in NAS-7400 

 Event Log in NAS-7400 

 Your email inbox  
 

8.2 Checking the System Status LED 

The NAS-7400 system status LED reports the condition of the Enclosure fan 

and power supply: 

 Green – Normal Enclosure function 

 Amber – There is a problem with the fan or power supply 

 Red – The fan, power supply, or file system has failed 

If your NAs-7400 is configured to work with a UPS, it will continue to run 

after a power supply failure. 
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8.3 Checking Disk Status LEDs 

The disk status LEDs report the condition of the disk drives: 

 Green – Normal disk drive function 

 Amber – Rebuilding to this disk drive 

 Red – Failed disk drive 

 Dark – No disk drive is installed 

 

 

NAS-7400 Disk and System Status LEDs 
 

8.4 Replacing a Failed Disk Drive 

Replace the failed disk drive with a new disk drive of the same or slightly 

greater capacity. You do not have to power down the NAS-7400.  

i. Open the NAS-7400’s front door. 

ii. Pull out the drive carrier with the failed drive. 

iii. Remove the failed disk drive from the drive carrier. 

iv. Install a new disk drive into the carrier. 

v. Place the carrier with the new disk drive back into the open slot in 

the NAS-7400. 

 

If the failed drive belonged to a RAID Volume, the RAID Volume will begin 

rebuilding as soon as the new drive is installed. 

During the Rebuild, the Disk Status LED shows amber. When the Rebuild is 

finished, the Disk Status LED turns green. 

Disk Status LED 

System Status 
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If the replacement drive is free, that is, not assigned to a RAID Volume or as 

a spare, the Disk Status LED remains dark after you install the new drive. 
 

8.5 Checking RAID Volume Status in PASM 

To view RAID Volume status: 

i. Start PASM. 

ii. In the Tree, click on the “+” button beside the “RAID & File 

System” icon. 

iii. Click on the “RAID Management” icon. The status is displayed in 

the RAID Status tab. 

RAID Critical icon

Rebuild in
progress

 

PASM reports a Critical RAID Volume 
 

NAS-7400 Responds to a Critical RAID Volume 

How the NAS-7400 responds to a Critical RAID Volume depends on the RAID 

level of your Volume and whether you have a spare drive available: 

 

 For a RAID 1 Volume or a three-drive RAID 5 Volume, if a spare 

drive is available, the RAID Volume begins rebuilding itself 

automatically. 

 For RAID 1, 5, and 10 Volumes, when no spare drive is available, 

you must replace the failed disk drive. The RAID Volume will begin 

rebuilding itself when you install the new disk drive. 

 RAID 0 Volumes go offline after a disk drive failure. A RAID 0 

Volume cannot be rebuilt. All data on the Volume is lost.  
 

Additional Details about Rebuilds 

 The Rebuild takes several minutes, depending on the size of your 

disk drives. 
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 During a rebuild, you can access your folders on the NAS-7400. 

 When you replace the failed disk drive with a new disk drive, the 

new disk drive becomes a Free Drive. 

Responding to an Invalid RAID Volume 

The NAS-7400 considers a RAID Volume invalid when the RAID Volume was 

created by a different NAS-7400. However, the RAID Volume itself remains 

functional and the data on it is safe. 

This condition could happen when you: 

 Move the disk drives from one NAS-7400 to a different NAS-7400. 

 Remove the disk drives in order to send your NAS-7400 for service. 

Use the Recover function to validate the RAID Volume. The Recover tab is 

only active when an invalid RAID Volumes present and can be recovered. 

RAID Critical icon

Recover tab
is active

RAID Volume is
functional

 

An invalid RAID Volume in PASM 
 

Using the Recover Function 

To validate the RAID Volume: 

 In the Tree, click on the “+” button beside the “RAID & File 

System” icon. 

 Click on the “RAID Management” icon. 

 Click on the “Recover” tab. 

 On the “Recover” tab, click on the option button beside the invalid 

RAID Volume. 

 Click on the “OK” button. 

 The NAS-7400 will reboot itself to update its configuration and 

recognize the RAID Volume. 

 

Note 
Running the Recover function might erase some or all of your 

NAS-7400 settings. 
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8.6 Checking File System Status in PASM 

Typically the first indication of a problem with the NAS-7400’s file system is 

when your network drive becomes unavailable. 

You might also see the message, “File system contains errors. Please check.” 

when you click on the icons under the File & Print menu. 

To view File System status: 

i. Start PASM. 

ii. In the Tree, click on the “+” button beside the “RAID & File 

System” icon. 

iii. Click on the “File System Management” icon. 

iv. Look for the RAID Volume “ ” icon on the File System Status tab. If 

the RAID Volume icon is Critical “ ”, the file system contains errors 

and you must rebuild the file system. See below.  

Rebuilding the File System 
 

Note 
When you rebuild a File System, you delete all the folders in the RAID 

volume and all the data saved in the folders. 
 

To rebuild a File System: 

i. In the Tree, click on the “+” button beside the “RAID & File 

System” icon. 

ii. Click on the “File System Management” icon. 

iii. In the “File System Status” tab, click on the “RAID Volume 

Critical ”icon to display the “Rebuild File System” button. 

iv. Click on the “Rebuild File System” button. 

v. In the confirmation box, type “yes” into the field provided and click 

the “OK” button. 
 

8.7 Checking the Event Log in PASM 

To view the Event Log in PASM: 

To check Enclosure status: 

i. Start PASM. 

ii. In the Tree, click on the “+” button beside the “Management” 

icon. 
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iii. Click on the “Event Log” icon. 

iv. The Event Log displays. See The PASM Event Log 

 

The PASM Event Log 

 
v. Check the Event Log for reports of disk drive failure or other 

problems. 
 

Responding to Events 

All events are reported in the Event Log. Most events are simply reports that 

the NAS-7400 is responding to your commands. 

Many events are also reported via email. The NAS-7400’s buzzer sounds for 

serious events that require your attention. 

A list of event categories is shown below: 

 File System 

 NAS Replication 

 Snapshots 

 System (enclosure) 

 Disk Drives 

 RAID Volumes 

 

Reported Event Corrective Action 

File System 

File system of volume X content 
errors! Check the system before 
continuing. 

The file system has a problem. Reboot 
the NAS-7400 and check file system 
again. If the event appears again, the 
file system has crashed. Rebuild the file 
system. 
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File system capacity usage of 

volume X is over 90%. Reduce the number or size of the files or 

expand the volume size.  File system capacity usage of 

volume X is 100%. 

Rebuilding file system... The file system is being rebuild by user 

action. 

NAS Replication 

NAS replication is completed. NAS replication has finished. Normal. 

System is busy. NAS replication is 

abort! 

The RAID Volume is currently 

formatting, rebuilding, or migrating. 

Wait until this process is done. Then try 

the replication again. 

System is doing another 

replication. NAS replication is 

abort! 

The NAS-7400 is currently doing a 

replication. Wait until the current 

replication is done. Then try the second 

replication again. 

NAS replication is failed! There is a failed network connection 

between the two NAS-7400s. Correct 

the problem and try again.  

Snapshots 

The snapshot capacity usage 

which timestamp is [date and 

time] of volume X is over 90%. 

Move the snapshot volume to another 

storage location. 

Or delete the snapshot and then create a 

new one. 

System is busy. Snapshot 

creation was aborted! 

The RAID Volume is currently 

formatting, rebuilding, or migrating. 

Wait until this process is done. Then try 

the snapshot again. 

System is creating another 

snapshot. Snapshot creation was 

aborted! 

The NAS-7400 is currently doing a 

snapshot. Wait until the current 

snapshot is done. Then try the second 

snapshot again. 
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System (enclosure) 

System is starting to work. 

Normal. System is rebooting. 

System is shutting down. 

System was shut down 

abnormally. 

The NAS-7400 shut down incorrectly the 

last time. 

CPU temperature is higher than 

50℃/122℉. System will shut 

down. 

Allow the NAS-7400 to cool for several 

minutes. Then restart the NAS-7400 and 

check system temperature and fan 

operation.  

Be sure there is adequate air circulation 

around the NAS-7400. 

System temperature is higher 

than 50℃/122℉. System will 

shut down. 

System fan speed is lower than 

1500 RPM. Check the system 

before continuing. 

Replace the fan.  

AC Power failure. System will shut 

down. 

Restore the AC power. Then restart the 

NAS-7400. 

Disk Drives 

Task X timeout on disk Y at LBA 

[address] 

A LBA error. Check the disk drives. 

Check the RAID Volume. Replace the 

disk drive or rebuild the RAID Volume as 

needed. 
Task X disk error on disk Y at LBA 

[address] with status Z 

S.M.A.R.T threshold exceeded on 

disk X 

Check the disk drives. Replace the failed 

drive.  

BSL update on disk X at LBA 

[address] 

Bad sector on a disk drive. Check the 

disk drives. Replace the disk drive if it 

continues to receive BSL updates. 

BSL log disk X at LBA [address] 

cleared 

Check the disk drives.  

Delete Spare Disk Delete a spare drive. Normal. 
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RAID Volumes 

Create [RAID name, RAID level 

and X number of disk drives]  

Create a RAID Volume. Normal. 

Delete RAID X Delete a RAID Volume. Normal. 

Migration or Rebuilding on array X 

started. 

RAID Volume Migration or Rebuild has 

started. Normal. 

Migration or Rebuilding on array X 

at Y%. 

Progress report on RAID Volume 

Migration or Rebuild. Normal. 

Migration or Rebuilding on array X 

paused at Y%. 

RAID Volume Migration or Rebuild was 

paused temporarily by user action.  

Migration or Rebuilding on array X 

resumed at Y%. 

RAID Volume Migration or Rebuild was 

paused and then resumed by user 

action. 

Migration or Rebuilding on array X 

completed. 

RAID Volume Migration or Rebuild has 

finished. Normal. 

Migration or Rebuilding on array X 

aborted at Y% 

RAID Volume Migration or Rebuild was 

aborted (stopped) by user action.  

Migration or Rebuilding on array X 

aborted at Y% because of error. 

RAID Volume Migration or Rebuild has 

aborted (stopped) because of an error. 

Check the disk drives. Check the RAID 

Volume.  

RAID status: "OFFLINE". The 

NAS-7400 X volume Y is offline. 

Check the disk drives. Replace the failed 

drive. Create a new RAID Volume.  

RAID status: "CRITICAL". The 

NAS-7400 X volume Y is not 

functioning correctly. 

Check the disk drives. Replace the failed 

drive. The RAID Volume will rebuild 

automatically. 

RAID X had some errors. 

Formatting was aborted! 

Check the disk drives. Replace the failed 

drive.  
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8.8 Checking Enclosure Status in PASM 

To check Enclosure status: 

i. Start PASM. 

ii. In the Tree, click on the “+” button beside the “System” icon. 

iii. Click on the “System Information” icon. 

iv. Click on the “Enclosure Information” tab. 

Overheat icon

Failed fan icon

Out-of-spec
power icon

 

The Enclosure Information tab with malfunctions shown 

 

The corrective action you take depends on the nature of the problem: 
 

i. If CPU or system temperature is above specification: 

 Be sure there is adequate air flow around the NAS-7400. 

 Be sure the ambient temperature is below 35℃ (95℉). 

 Check the fan speed. 

ii. If the fan speed is below specification, replace the NAS-7400’s disk 

drive cooling fan.  

iii. If any power status is out-of-specification, replace the NAS-7400’s 

power supply. 
 

8.9 Resolving Connections with SmartSYNC 

The SmartSYNC utility is designed to detect the NAS-7400 on your network. 

If SmartSYNC does not detect your NAS-7400, check the following items: 

i. Be sure the NAS-7400 is powered up and fully booted. 

ii. The Power Button and System Status LED should be green.  
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iii. Be sure the NAS-7400 is properly connected to your network. 

iv. The Ethernet Activity LED should be green or blinking green. 

v. Be sure that SmartSYNC is looking on the same network where you 

connected the NAS-7400. 

 

 

Power Button, System Status and Ethernet Activity LEDs 
 

 

Multiple Network Connections 

If your PC has multiple network connections, you must verify that 

SmartSYNC is looking on the network where the NAS-7400 is installed: 

 

i. Open SmartSYNC. 

ii. In the dropdown menu, choose the IP address of the network 

interface card connected to the network where you installed the 

NAS-7400. 

 

 

8.10 Solving Network Connection Problems 

Most network connection problems are the result of poor connections. 

When the NAS-7400 is fully booted and connected to the network, the 

Ethernet Activity LED indicates status and activity: 

 Green – Network link is properly connected 

 Flashing Green – Network Activity 

 Dark – No Connection 

Power Button 

System Status 

 

Ethernet 

Activity LED 
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If your NAS-7400 is connected to your network but the Ethernet Activity LED 

on your NAS-7400 is dark, check the following items: 

 Verify that the switch, hub, or facility network service connection 

that you are using is operational. 

 Switches and hubs have LEDs that light when there is a connection 

and flash when there is activity. 

 Network service connections generally do not have LEDs to verify 

whether they actually are connected to the network. See your 

Network Administrator for assistance. 

 Be sure the network cable is firmly attached to the NAS-7400 

network connector at one end and to the network switch, hub, or 

facility network connection at the other. 

 If the cable connections are good, remove the existing network 

cable and install a known-good network cable. 
 

8.11 Checking Your Email Inbox 

If you enabled Mail Alert in PASM, the NAS-7400 will send you an email 

message when a problem arises. Look for a message from “root.” 

 

Email message from the NAS-7400. 

8.12 Restoring the Default Password 

Normally, you change your password in PASM.  

If you changed the password and then forgot the new password, you can 

reset the NAS-7400 to the default password: admin. Use a straightened 

paper clip or the tip of a ball-point pen as a reset tool. 

To reset the Administrator’s password: 

i. Verify that the NAS-7400 is fully booted. 
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ii. Insert your reset tool into the reset button hole on the back of the 

NAS-7400.Press and hold the reset button for eight seconds, until 

the System Status LED flashes three times. 

iii. The Administrator’s password is now reset to admin. 
 

 

 

 

Reset button and System Status LED 

8.13 Resolving a Windows Firewall Issue 

If you a running a personal firewall on your Windows PC, the firewall might 

prevent the you from accessing the NAS-7400 over your network. 

Follow this procedure to add an exception for the NAS-7400: 

i. From the Windows “Start menu >Settings > Network 

Connections”. The Network Connections window opens. 

Right-click on Local Area Connection and choose Properties from 

the popup menu. 

System Status 

LED 

Reset Button  
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ii. The local Area Connection properties dialog box opens. Click on the 

“Advanced” tab. 

iii. Click the “Settings” button. 

iv. The Windows Firewall dialog box opens. Click on the “Advanced” 

tab. 

v. Under Network Connection Setting, click the “Settings” button. 

vi. The Advanced Settings dialog box opens. Click the “Add” button. 

vii. The Service Settings dialog box opens. In the Description of service 

field, type PLANET NAS utility. 

viii. In the Name or IP address field, type the IP address of the 

NAS-7400. 

ix. In the External Port field, type 49152. 

x. Click on the “UDP” option button. 

xi. In the Internal Port field, type 49152. 

xii. Click the “OK” button. 

xiii. Click the “OK” buttons in the Advanced Settings, Windows Firewall, 

and Local Area Connection Properties dialog boxes.  

 

Windows Firewall Advanced Service Settings 

 

8.14 Frequently Asked Questions 

Q1: The NAS-7400 worked OK until I turned it off. When I turned it on again, 

my Windows network drive connection no longer works. 

A1: When you powered up the NAS-7400, the DHCP server assigned a 

different IP address to the NAS-7400. Here are two possible solutions: 

 You may be able to reset the NAS-7400’s IP address manually. Note 

that changing the NAS-7400’s IP address may cause an IP address 

conflict on your network. Check with your Network Administrator 

before taking this action. 
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 If you cannot restore the previous IP address, you must create new 

network drives and printer connections.  

 

 

Q2: When I start Windows, a message displays that says, “Could not 

reconnect all network drives.” 

A2: The NAS-7400 reconnects to your PC shortly after Windows starts. In 

most cases, the NAS-7400 network drives will be available by the time you 

click on them. 
 

Q3: The NAS Setup Wizard cannot access the NAS-7400 over the network. 

A3: If you a running a personal firewall on your Windows PC, the firewall 

might prevent you from accessing folders on the NAS-7400. You must do 

one of the following actions: 

 Disable the firewall  

 Add an exception for the NAS-7400 

 

 

Q4: I tried to connect my NAS-7400 as a network drive using SmartSYNC, 

but Windows displayed an error message. 

A4: There might be an IP address conflict between the NAS-7400 and 

another device on your network. See your Network Administrator for 

assistance. 

 

Q5: I cannot log into the NAS-7400 with through the AD Domain. 

A5: Be sure you use a “domain name\user name” when you log into the 

NAS-7400 using SMB, FTP, or AFP. You must use the “\” character. 

Many FTP clients do not support a space in the domain name or user name. 

Also, the NAS-7400 does not support a user home directory. 
 

Q6: How does the NAS-7400 integrate into an NIS Domain? 

A6: If the NIS domain account or group name is the same as the NAS-7400, 

the NAS-7400 will apply them to its account or group. 

If the NAS-7400 joins a NIS Domain, joining only affects the NFS service and 

Quota settings. The other services are not affected. 
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Q7: How are non-ASCII folder file names displayed? 

A7: The NAS-7400 supports Unicode, so you can use non-ASCII characters 

in your folder names. Windows 98 and ME do not support Unicode, so they 

cannot display your folder names properly. But you can still access your 

folders. 

 

Q8: I tried to copy a Windows shortcut to my network drive, but an error 

message says there is not enough free disk space. 

A8: Normally, you can copy a Windows shortcut to a network drive. However, 

if the network drive is a USB drive or memory stick with FAT32 file format, 

the NAS-7400 might not recognize the shortcut and prevent you from 

copying it. 

If this situation occurs, choose a different folder in which to copy the 

shortcut. 
 

Q9: Does NAS-7400 support a USB drive or memory stick with FAT16 file 

format? 

A9: No. If you attach the FAT16 USB drive or memory stick to NAS-7400, 

you can see the files on it. But if you attempt to copy files to the drive or 

memory stick, Windows might display a disk full message. 

 

Q10: How do I remove a USB drive or memory stick from the NAS-7400? 

A10: Be sure that no files on the USB drive or memory stick are still open. 

Then unplug the USB drive or memory stick from the NAS-7400. The 

NAS-7400 automatically un-mounts the USB drive or memory sticks. 
 

Q11: Can I do a One Touch Backup or a regular Backup on a protected folder 

or file on my Windows PC? 

A11: No. Windows does not allow SmartSYNC to access protected folders 

and files. If you want to perform a backup, you must first disable protection 

on your folders and files. 

 

Q12: Which FTP clients are compatible with the NAS-7400’s FTP server? 

A12: We recommend FTP clients that support Unicode, such as Filezilla or 

Smart FTP for Windows, Filezilla for Linux, and Transmit v3.5.5 for 

Macintosh. 

If your FTP client does not support Unicode, only use ASCII characters to 

name your shared folders on NAS-7400. 
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Q13: I cannot find the DLNA Server tab under Protocol Control in PASM. 

A13: You must download and install the DLNA plug-in on your NAS-7400 to 

access this feature. 
 

Q14: Can I move the disk drives from one NAS-7400 to a different 

NAS-7400? 

A14: Yes. However, to access the RAID Volume on the new NAS-7400, you 

must run the Recover function. When NAS-7400’s memory does not match 

the RAID Volume on the disk drives, the RAID Volume is considered invalid 

and the Recover function becomes available.  

 

Q15: I set up email alert recipients but they never receive any messages. 

A15: In most cases, you must setup SMTP authentication in order for your 

alert messages to pass your SMTP server. 

 

Q16: Can NAS-7400 handle jumbo frames? 

A16: Yes. But you must set the maximum frame size in PASM. 
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Appendix A: Maintenance 

Upgrading the Firmware 

Follow this procedure to upgrade the firmware on your NAS-7400. 

Downloading the Upgrade File 

To download the upgrade file: 

i. Download the latest firmware upgrade file from the PLANET website 

onto your PC. 

ii. Copy the firmware upgrade file from your PC to a folder on the 

NAS-7400. 

 

Installing the Upgrade File 

i. Start the PASM interface. 

ii. In the Tree, click on the + beside the Management icon. 

iii. Click on the System Upgrade icon. 

iv. From the Volume dropdown menu, choose the Volume that has the 

folder with the firmware image file. 

v. From the Folder dropdown menu, choose the Folder that contains 

the firmware upgrade file. 

vi. In the File Name field, type the name of the firmware upgrade file. 

vii. Click the OK button to begin the upgrade. 

viii. The upgrade takes about two to three minutes.  
 

Note 
Do not disconnect the power or shut down the NAS-7400 while 

the upgrade is running! 
 

ix. When the upgrade is done, a system message appears. 

x. Click the OK button on the system message. 
 

Rebooting the NAS-7400 

To reboot the NAS-7400 after a firmware upgrade: 

i. In the Tree, click on the + beside the System icon. 

ii. Click on the Reboot / Shutdown icon. 
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iii. Click on the Reboot option. 

iv. Click the OK button. 

v. In the confirmation box, click the OK button. 

vi. The reboot runs automatically. When the NAS-7400 is fully booted: 

 The System Status LED turns green (right) 

 The buzzer beeps one time (if the buzzer is enabled) 

 

 

 

Installing Application Plug-in 

Application plug-in is enhancements to NAS-7400’s capabilities. The DLNA 

server, which enables NAS-7400 to support the UPnP protocol, is one 

example of an application plug-in. 

Follow this procedure to install an application plug-in on your NAS-7400. 

 

Downloading the Plug-in File 

i. To download the plug-in file: 

ii. Download the plug-in file you want from the PLANET website onto 

your PC. 

iii. Copy the plug-in file from your PC to a folder on the NAS-7400. 

 

Installing the Plug-in File 

i. Please copy the plug-in file from your PC to a folder on the NAS-7400. 

ii. Start the PASM interface. 

iii. Please click on the "File & Print Application Plug-ins/ icon. Click on the 

Application Plug-ins icon. 

iv. From the "Volume" dropdown menu, choose the Volume that has the 

folder with the plug-in file. 

v.  From the Folder dropdown menu, choose the Folder that contains the 

plug-in file. 

System Status LED 
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vi. In the File Name field, type the name of the plug-in file. 

vii. Click the OK button to begin the installation. 

 

 

Note 
Do not disconnect the power or shut down the NAS-7400 while 

the installation is running! 
 

When the installation is done, a system message appears. 

Click the OK button on the system message. 

 

Rebooting the NAS-7400 

To reboot the NAS-7400 after a plug-in installation: 

i. In the Tree, click on the + beside the System icon. 

ii. Click on the Reboot / Shutdown icon. 

iii. Click on the Reboot option. 

iv. Click the OK button. 

v. In the confirmation box, click the OK button. 

vi. The reboot runs automatically. When the NAS-7400 is fully booted: 

vii. The System Status LED turns green (right) 

viii. The buzzer beeps one time (if the buzzer is enabled) 

 

 

 

 

Replacing the Fan 

Follow this procedure to replace the disk drive cooling fan on the NAS-7400: 

Shutdown and Disconnect 

i. In the Tree, click on the + beside the System icon. 

ii. Click on the Reboot / Shutdown icon. 

iii. Click the Shutdown option and click the OK button. 

System Status LED 
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iv. In the confirmation box, click the OK button. 

v. Wait until the LEDs on the front of the NAS-7400 go dark. 

vi. Disconnect the power cord, network cable, and USB cable. 

 

Remove and Replace the Fan 

i. Remove the four screws on the back of the enclosure. 

ii. Carefully remove the back panel from the enclosure. 

iii. Disconnect the fan power harness from its connector on the 

motherboard. 

iv. Gently pull the two retainer clips away from the cooling fan. 

v. Lift the cooling fan off the locating pins. 

vi. Check the direction arrow on the new fan to be sure it blows 

outward. 

vii. Align the new fan with the locating pins on the back panel and 

gently press the fan into place on the panel. 

viii. The fan snaps into place between the retainer clips. 

ix. Reconnect the fan power harness to its connector on the 

motherboard. 

x. Place the back panel onto the enclosure and install the four screws 

to attach the back panel to the enclosure. 

 

 

 
Reconnect and Power-up 

i. Reconnect the power cord, network cable, and USB cable. 

ii. Press the Power Button on the front of the NAS-7400 (right).When 

the NAS-7400 is fully booted: 

 The System Status LED turns green 

 The buzzer beeps one time (if the buzzer is enabled)  

Power Button 

System 

Status  
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Replacing the Power Supply 

Follow this procedure to replace the power supply on the NAS-7400: 

Shutdown and Disconnect 

i. In the Tree, click on the + beside the System icon. 

ii. Click on the Reboot / Shutdown icon. 

iii. Click the Shutdown option and click the OK button. 

iv. In the confirmation box, click the OK button. 

v. Wait until the LEDs on the front of the NAS-7400 go dark. 

vi. Disconnect the power cord, network cable, and USB cable. 

vii. Open the front door, remove the disk drive carriers, and set aside 

the carriers. 
 

Disassemble the Enclosure 

i. Remove the four screws on the back of the enclosure. 

ii. Carefully remove the back panel from the enclosure. 

iii. Disconnect the fan power harness from its connector on the 

motherboard, then set side the back panel. 

iv. Pick up the NAS-7400 and turn the NAS-7400 upside down. 

v. Remove the five screws from the bottom of the enclosure. 

vi. Gently pull the silver side panel away from the chassis. 

vii. Gently slide the blue side panel forward (toward the disk drive end), 

then away from the chassis. 

viii. Lift the bottom panel from the back end and slide it off the chassis. 

 

Remove and Replace the Power Supply 

i. Remove the three screws that attach the power supply at the back 

panel. 

ii. One screw is beside the power connector, two screws are beside the 

power supply fan.  

iii. Remove the screw attaching the power supply to the NAS-7400 

chassis, inside near the wiring harness. 

iv. Pull the power supply wiring harness from underneath the chassis 

and carefully lift the power supply out of the chassis. 

v. Disconnect the power supply wiring harness from the power 

connector on the motherboard. 

vi. Remove the angle bracket from the old power supply. 
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vii. Attach the angle bracket to the new power supply. 

viii. Connect the power supply wiring harness to the power connector 

on the motherboard. 

ix. Place the power supply onto the chassis. 

x. Be sure all of the screw holes line up. 

xi. Gently push the power supply wiring harness into the chassis. 

xii. Be sure to route the wires are away from metal edges. 

xiii. Install the screw attaching the power supply to the NAS-7400 

chassis, inside near the wiring harness. 

xiv. Install the three screws that attach the power supply to the back 

panel. 

xv. One screw is beside the power connector, two screws are beside the 

power supply fan. 
 

Reassemble the enclosure 

i. Place the bottom panel onto the NAS-7400 chassis. 

ii. The bottom panel locks under the front (disk drive end) panel. 

iii. Place the blue side panel beside the NAS-7400 chassis and slide it 

into place. 

iv. Place the silver side panel onto the chassis. 

v. The silver panel snaps into place. 

vi. Install the five screws that attach the bottom of the enclosure. 

vii. Turn the enclosure over and place it on its feet. 

viii. Reconnect the fan power harness to its connector on the 

motherboard. 

ix. Place the back panel onto the enclosure and install the four screws 

to attach the back panel to the enclosure. 
 

Reconnect and Power-up 

i. Reconnect the power cord, network cable, and USB cable. 

ii. Reinstall the disk drive carriers into the NAS-7400 and close the 

front door. 

iii. Press the power button on the front of the NAS-7400 (right). When 

the NAS-7400 is fully booted: 

 The System Status LED turns green 

 The buzzer beeps one time (if the buzzer is enabled)  
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Connection Problems after Restart 

If your NAS-7400’s network settings were set to Obtain an IP address 

automatically, your DHCP server might assign a different IP address to the 

NAS-7400 when you restart the NAS-7400 after is was shutdown for repairs. 

This condition does not apply if you assigned your NAS-7400’s IP address 

manually. 

If you experience network drive or printer connection failures, check the 

NAS-7400’s current IP address. If the NAS-7400’s IP address has changed, 

your previous network drives and printer connections will no longer work. 

Here are two possible solutions: 

 You may be able to reset the NAS-7400’s IP address manually. Note 

that changing the NAS-7400’s IP address may cause an IP address 

conflict on your network. Check with your Network Administrator 

before taking this action. 

 If you cannot restore the previous IP address, you must create new 

network drives and printer connections. 
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Appendix B Specification 

Product  4-Bay SATA NAS RAID Server 
Model NAS-7400 

Hardware Specification  

Supported HDD Four 3.5”, SATA I/II interface  

LAN Connector One RJ-45 Interface (10/100/1000Mbps) 

Standards IEEE 802.3, IEEE 802.3u, IEEE802.3ab 

USB Connector 2 x USB 1.1/2.0 Compatible (Type A) 

USB Connectivity Print Server, External HDD connection, APC 

Smart UPS 

Support Protocol TCP/IP, HTTP, FTP, SMB 

Client OS Windows, Mac OS, Linux/Unix 

System Configuration Windows Base utility, Web Browser 

Supported Concurrent 

Users 

Up to 16 

Max. User Account Up to 512 

Share Folder Up to 1024 

File Language Format 6 (English, French, German, Italian, Spanish 

and Russian) 

Environment Specifications  

Dimension (W x D x H) 230 x 188 x 153(W x D x H)   

Power Input Voltage: 100-240V AC, 4A-2A, 50-60Hz 

FUSE: 6.3A / 250V 

Operating Environment Operating temperature: 5~35 Degree C 

Storage temperature: -10~60 Degree C 

Relative Humidity:10~85 %( non-condensing) 

Emission FCC, CE 

 



 

 
EC Declaration of Conformity 

 
 
For the following equipment: 
 
*Type of Product : 4-Bay SATA NAS RAID Server 
*Model Number : NAS-7400 
 
* Produced by: 

 Manufacturer‘s Name  : Planet Technology Corp. 
Manufacturer‘s Address : 11F, No. 96, Min Chuan Road, Hsin Tien, 

Taipei, Taiwan, R.O.C. 
 
is herewith confirmed to comply with the requirements set out in the Council Directive on the  
Approximation of  the Laws of the Member States relating to Electromagnetic Compatibility 
(89/336/EEC, 92/31/EEC, 93/68/EEC).  
For the evaluation regarding the Electromagnetic Compatibility, the following standards were 
applied: 

 
EN 55022 (2006, Class B) 

CISPR 22 (1997 + A1 :2000, Class B) 
ICES-003             (2004, Class B) 

EN 61000-3-2 (2000) 
EN 61000-3-3 (1995+A1: 2001) 
EN 55024 (1998+A1: 2001+A2: 2003) 

IEC 61000-4-2 (2001) 
IEC 61000-4-3 (2002) 
IEC 61000-4-4 (1995 + A1:2000 + A2:2001) 
IEC 61000-4-5 (2001) 
IEC 61000-4-6 (2001) 
IEC 61000-4-8 (2001) 
IEC 61000-4-11 (2001) 

 
 
Responsible for marking this declaration if the: 
 
⌧ Manufacturer � Authorized representative established within the EU 
 
Authorized representative established within the EU (if applicable): 
 
Company Name:  Planet Technology Corp. 
 
Company Address: 11F, No.96, Min Chuan Road, Hsin Tien, Taipei, Taiwan, R.O.C 
 
Person responsible for making this declaration 
 
Name, Surname   Jonas Yang 
 
 Position / Title : Product Manager 
 
 
  Taiwan    6 th  April, 2008 
  Place       Date    Legal Signature 

PLANET TECHNOLOGY CORPORATION 
e-mail: sales@planet.com.tw   http://www.planet.com.tw 

11F, No. 96, Min Chuan Road, Hsin Tien, Taipei, Taiwan, R.O.C. Tel:886-2-2219-9518 Fax:886-2-2219-9528 
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